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Preface 

 
The primary focus of any engineering laboratory/ field work in the technical education system 

is to develop the much needed industry relevant competencies and skills. With this in view, MSBTE 

embarked on this innovative ‘I’ Scheme curricula for engineering diploma programmes with outcome-

base education as the focus and accordingly, relatively large amount of time is allotted for the practical 

work. This displays the great importance of laboratory work making each teacher; instructor and 

student to realize that every minute of the laboratory time need to be effectively utilized to develop 

these outcomes, rather than doing other mundane activities. Therefore, for the successful 

implementation of this outcome-based curriculum, every practical has been designed to serve as a 

‘vehicle’ to develop this industry identified competency in every student. The practical skills are 

difficult to develop through ‘chalk and duster’ activity in the classroom situation. Accordingly, the ‘I’ 

scheme laboratory manual development team designed the practical to focus on the outcomes, rather 

than the traditional age old practice of conducting practical to ‘verify the theory’ (which may become a 

byproduct along the way). 

 

This laboratory manual is designed to help all stakeholders, especially the students, teachers 

and instructors to develop in the student the pre-determined outcomes. It is expected from each student 

that at least a day in advance, they have to thoroughly read through the concerned practical procedure 

that they will do the next day and understand the minimum theoretical background associated with the 

practical. Every practical in this manual begins by identifying the competency, industry relevant skills, 

course outcomes and practical outcomes which serve as a key focal point for doing the practical. The 

students will then become aware about the skills they will achieve through procedure shown there and 

necessary precautions to be taken, which will help them to apply in solving real-world problems in 

their professional life.  

 

This manual also provides guidelines to teachers and instructors to effectively facilitate 

student-centered lab activities through each practical exercise by arranging and managing necessary 

resources in order that the students follow the procedures and precautions systematically ensuring the 

achievement of outcomes in the students.   

 

Mechanical, Plastic, Automobile and allied Industries need to build computer based models of 

desired product to perform different analyses before sending them for manufacturing so as to avoid 

wastage of resources. These models are being created using computer aided design software through 

‘solid modeling module’ of the software. The same solid model can be send to rapid prototype 

machines and 3D printers for direct additive manufacturing also. This course will enable the students 

to inculcate solid modeling and additive manufacturing concepts and methodology to solve 

engineering problems 

 

Although all care has been taken to check for mistakes in this laboratory manual, yet it is 

impossible to claim perfection especially as this is the first edition. Any such errors and suggestions 

for improvement can be brought to our notice and are highly welcome. 
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Programme Outcomes (POs) to be achieved through Practical of this 

Course: 

 

PO 1. Basic knowledge: Apply knowledge of basic mathematics, sciences and basic 

engineering to solve the broad-based mechanical engineering problems. 

PO 2. Discipline knowledge: Apply mechanical engineering knowledge to solve broad-

basedmechanicalengineering related problems.  

PO 3. Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-basedmechanicalengineering problems.   

PO 4.  Engineering tools: Apply  relevant  mechanical technologies and tools with an 

understanding of the limitations  

PO 5. The engineer and society: Assess societal, health, safety, legal and cultural issues and 

the consequent responsibilities relevant to practice in field of mechanical engineering. 

PO 6. Environment and sustainability: Apply mechanical engineering solutions also for 

sustainable development practices in societal and environmental contexts.   

PO 7. Ethics: Apply ethical principles for commitment to professional ethics, responsibilities 

and norms of the practice also in the field of mechanical engineering. 

PO 8. Individual and team work: Function effectively as a leader and team member in 

diverse/ multidisciplinary teams.   

PO 9. Communication: Communicate effectively in oral and written form.   

PO 10. Life-long learning: Engage in independent and life-long learning activities in the 

context of technological changes also in the mechanical engineering and allied 

industry. 

 

Program Specific Outcomes (PSOs) 

PSO 1: Modern Software Usage:  Use latest mechanical related software for simple design,  

             drafting, manufacturing, maintenance and documentation of mechanical components  

           and processes. 

PSO 2: Maintenance and selection of machines, equipment, instruments: Maintain and  

            select appropriate machine, equipment and instrument in field of Mechanical  

            Engineering. 

PSO 3: Manage Mechanical Process:  Manage the mechanical process by selection and  

             scheduling right type of machinery, equipment, substrates, quality control techniques,  

           operational parameters and software for a particular mechanical process or job for  

           economy of operations. 
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List of Industry Relevant Skills 

 

The following industry relevant skills of the competency Use Solid Modeling and Additive 

Manufacturing are expected to be developed in you by undertaking the practical of this 

laboratory manual. 

a. Prepare 2D Drawings using sketcher workbench of any parametric CAD software. 

b. Generate 3D Solid models from 2D sketches using Part workbench of any parametric 

CAD software.  

c. Prepare assemblies of part models using Assembly workbench of any parametric CAD 

software.  

d. Generate orthographic views of 3D solid models/assemblies using drafting workbench 

of any parametric CAD software. 

e. Generate production drawings for given part models/assemblies. 

f. Print components using 3D Printer/Rapid prototyping machine.
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Practical- Course Outcome matrix 

Course Outcomes (COs) 

a. Prepare 2D Drawings using sketcher workbench of any parametric CAD software. 

b. Generate 3D Solid models from 2D sketches using Part workbench of any parametric 

CAD software.  

c. Prepare assemblies of part models using Assembly workbench of any parametric CAD 

software.  

d. Generate orthographic views of 3D solid models/assemblies using drafting workbench 

of any parametric CAD software. 

e. Generate production drawings for given part models/assemblies. 

f. Print components using 3D Printer/Rapid prototyping machine 

Sr. No. Practical Outcome 
CO 

a. 

CO 

b. 

CO 

c. 

CO  

d. 

CO 

e. 

CO 

f. 

1.  

Prepare drawing template consisting of 

name plate boundary lines and projection 

symbol.  

√ - - - - - 

2.  

Draw and print two simple 2D geometries 

using sketcher commands 
√ - - - - - 

3.  
Draw and print two complex 2D 

geometries using sketcher commands 
√ - - - - - 

4.  
Draw and print the given two simple 3-D 

drawings using 3D modeling commands 
√ √ - - - - 

5.  

Develop solid models of individual 

components of Bench vice / Drill Jig / 

Screw Jack / Tool Post / anyone assembly 

consisting of at least five parts. (Problem 1)  

√ 
√ √ - - - 

6.  

Develop solid models of individual 

components of Bench vice / Drill Jig / 

Screw Jack / Tool Post / anyone assembly 

consisting of at least five parts. (Problem 1 

continued) 

√ 
√ √ - - - 

7.  Develop solid models of individual 

components of Bench vice / Drill Jig / 

Screw Jack / Tool Post / anyone assembly 

consisting of at least five parts. (Problem 1 

continued) 

√ 
√ √ √ - - 

8.  Develop solid models of individual 

components of Bench vice / Drill Jig / 

Screw Jack / Tool Post / anyone assembly 

consisting of at least five parts. (Problem 1 

continued) 

√ 
√ √ √ - - 
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9.  

Assemble and print the orthographic views 

of the assembly developed in PrO 5 to 8 

with bill of materials. ( Problem 2) 

√ 
√ √ √ 

√ 
 

10.  

Assemble and print the orthographic views 

of the assembly developed in PrO 5 to 8 

with bill of materials. ( Problem 2 

continued) 

√ 
√ √ √ 

√ 
- 

11.  

Assemble and print the orthographic views 

of the assembly developed in PrO 5 to 8 

with bill of materials. ( Problem 2 

continued) 

√ 
√ √ √ 

√ - 

12.  

Draw and print the production drawing of 

all individual components part models of 

assembly developed in PrO 5 to 8. 

(Problem 3)  

√ 
√ √ √ 

√ 
√ 

13.  

Draw and print the production drawing of 

all individual components part models of 

assembly developed in PrO 5 to 8. 

(Problem 3 continued) 

√ 
√ √ √ 

√ 
√ 

14.  

Draw and print the production drawing of 

all individual components part models of 

assembly developed in PrO 5 to 8. 

(Problem 3 continued) 

√ 
√ √ √ 

√ 
√ 

15.  
Print one simple component using 3D 

printer / Rapid prototyping machine. 
- - - - - √ 

16.  

Print one complex component using 3D 

printer / Rapid prototyping machine. 

(Problem 1) 

- - - - - √ 
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Guidelines to Teachers 

1. Teacher need to ensure that a dated log book for the whole semester, apart from the 

laboratory manual is maintained by every student which s/he has to submit for 

assessment to the teacher in the next practical session. 

2. There will be two sheets of blank pages after every practical for the student to report 

other matters(if any), which is not mentioned in the printed practicals. 

3. For difficult practicals if required, teacher could provide the demonstration of the 

practical emphasizing of the skills which the student should achieve. 

4. Teachers should give opportunity to students for hands-on after the demonstration. 

5. Assess the skill achievement of the students and COs of each unit. 

6. One or two questions ought to be added in each practical for different batches. For this 

teachers can maintain various practical related question banks for each course. 

7. If some repetitive information like data sheet, use of software tools etc. has to be provided 

for effective attainment of practical outcomes, they can be incorporated in Appendix. 

8. For effective implementation and attainment of practical outcomes, teacher ought to 

ensure that in the beginning itself of each practical, students must read through the 

complete write-up of that practical sheet. 

9. During practical, ensure that each student gets chance and takes active part in taking 

observations/ readings and performing practical. 

10. Teacher ought to assess the performance of students continuously according to the   

MSBTE guidelines 

 

 

Instructions for Students 
 

1. For incidental writing on the day of each practical session every student should maintain 

a dated log book for the whole semester, apart from this laboratory manual which s/he 

has to submit for assessment to the teacher in the next practical session. 

2. For effective implementation and attainment of practical outcomes, in the beginning 

itself of each practical, students need to read through the complete write-up including 

the practical related questions and assessment scheme of that practical sheet. 

3. Student ought to refer the data books, IS codes, Safety norms, Technical Manuals, etc. 

4. Student should not hesitate to ask any difficulties they face during the conduct of 

practical.  
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Content Page 

List of Practical and Progressive Assessment Sheet 

Sr. 

No 
Practical Outcome 

Page 

No. 

Date of 

performance 

Date of 

submi 

ssion 

Assess 

ment 

marks(25) 

Dated 

sign. of 

teacher 

Remarks 

(if any) 

1.  

Prepare drawing template consisting 

of name plate boundary lines and 

projection symbol.  

1 

  

 

 

 

 

2.  

Draw and print two simple 2D 

geometries using sketcher commands 23 

   

 

 

3.  

Draw and print two complex 2D 

geometries using sketcher commands 40 

   

 

 

4.  

Draw and print the given two simple 

3-D drawings using 3D modeling 

commands 
59 

   

 

 

5.  

Develop solid models of individual 

components of Bench vice / Drill Jig 

/ Screw Jack / Tool Post / anyone 

assembly consisting of at least five 

parts. (Problem 1)  

90 

   

 

 

6.  

Develop solid models of individual 

components of Bench vice / Drill Jig 

/ Screw Jack / Tool Post / anyone 

assembly consisting of at least five 

parts. (Problem 1 continued) 

98 

   

 

 

7.  

Develop solid models of individual 

components of Bench vice / Drill Jig 

/ Screw Jack / Tool Post / anyone 

assembly consisting of at least five 

parts. (Problem 1 continued) 

106 

   

 

 

8.  

Develop solid models of individual 

components of Bench vice / Drill Jig 

/ Screw Jack / Tool Post / anyone 

assembly consisting of at least five 

parts. (Problem 1 continued) 

119 

   

 

 

9.  

Assemble and print the orthographic 

views of the assembly developed in 

PrO 5 to 8 with bill of materials. 

(Problem 2) 

147 
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10.  

Assemble and print the orthographic 

views of the assembly developed in 

PrO 5 to 8 with bill of materials.  

(Problem 2 continued) 

168 

   

 

 

11.  

Assemble and print the orthographic 

views of the assembly developed in 

PrO 5 to 8 with bill of materials.  

(Problem 2 continued) 

190 

   

 

 

12.  

Draw and print the production 

drawing of all individual components 

part models of assembly developed in 

PrO 5 to 8. (Problem 3)  

203 

   

 

 

13.  

Draw and print the production 

drawing of all individual components 

part models of assembly developed in 

PrO 5 to 8. (Problem 3 continued) 

220 

   

 

 

14.  

Draw and print the production 

drawing of all individual components 

part models of assembly developed in 

PrO 5 to 8. (Problem 3 continued) 

226 

   

 

 

15.  

Print one simple component using 3D 

printer / Rapid prototyping machine. 232 

   

 

 

16.  

Print one complex component using 

3D printer / Rapid prototyping 

machine. (Problem 1) 
249 

   

 

 

Total    

 

Note: To be transferred to Proforma of CIAAN-2017. 

A suggestive list of PrOs is given in the above table. More such PrOs can be added to attain the COs and competency. A judicial mix 

of minimum 12 or more practical need to be performed, out of which, the practicals  marked as ‘*’ are compulsory, so that the 

student reaches the ‘Precision Level’ of Dave’s ‘Psychomotor Domain Taxonomy’ as generally required by the industry. 
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Practical No.1: Prepare drawing template consisting of name plate 

boundary lines and projection symbol. 
 

I. Practical Significance 

The main purpose of engineering drawing is to communicate to other engineers, 

machinists etc. by placing various views on a drawing sheet of different sizes. In 

additions to these standard views we also need to show border, title block, tables, and 

various special notes. To show additional details, either we use standard template 

formats available in software or we can modify these standard templates as per our 

requirement or we can create our custom based new template format. In these 

practical, we are going to create custom based new template format and extension of 

format file is *.frm.   

 

II   Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and allied 

industry.  

 

III  Competency and Skills 

This practical is expected to develop the following skills for the industry identified 

competency ‘Draw Title Block, border, projection symbols for engineering drawing. 

 

IV  Relevant Course Outcome(s) 

 Create our custom based new template format as per our requirement. 

 

V  Practical Outcome 

  Create custom based new template as per our requirement and use it to all drawings 

prepared in this subject. 

 

VI  Relative Affective Domain 

 Working in team work. 

 Practice good housekeeping. 

 Demonstrate working as a leader/a team member. 

 Follow ethical Practices. 

 

VII  Minimum Theoretical Background 

 Basic knowledge of computer handling. 

 Basic knowledge of template content. 



Solid Modelling and Additive Manufacturing (22053) 

 2 

 Knowledge of various sheet sizes. 

 Knowledge of solid modeling and format environment  commands. 

 

VIII Experimental setup  

 

               NIL. 

 

 

IX Resources Required 
 

S. 

No. 
Name of Resource Suggested Broad Specification Quantity 

1  
Hardware: Personal 

computer. 

(i5 or higher), RAM minimum 4 GB; 

A3 / A4 size printer / plotter. 

Display-wide Screen preferably. 

As  per 

batch size 

2  Operating system 
Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 

As  per 

batch size 

3  Software 
Any parametric solid modeling 

software. 

As  per 

batch size 

4  Plotter. Plotter A2 OR A3Size. 1 

 

X Precautions to be Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XI Procedure 

The first things you need to do if you want own customized format is to decide what it 

is going to look like. The best way to do that is to draw one out roughly on the relevant 

sized sheet of paper. As an example we are going to create an A4 sized landscape 

custom based template format (Here Solid Modeling CAD software is used).This is the 

guide to help you. You now have to determine how each element will be made. 

Considering following specifications of sample template for exercise as shown in 

Figure. 
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Problem Definition:Paper Size- A4 (297 X210 mm)Name Plate Size -150 X50 mm. 

Border-277X190mm  

 
 

 
 

 

Sr. 

No. 
Particular Color Width Height Thick 

Font/Alignment in 

cell 

1 Border(Inside offset 

by 10 mm 

Black 
1 -- -- 

-- 

2 Table Lines Brown 0.5 -- -- -- 

3 NAME,ROLL NO,SEM.& 

SEC.,SUB 

DATE,GRADE,SHEET 

NO.CECKED BY 

Red 

-- 4 1 

CG Times. 

Horizontally left. 

Vertically middle 

4 SCREW JACK 

ASSEMBLY 
Green 

-- 4 1 

CG Times. 

Horizontally center. 

Vertically middle 

5 INSTITUTE NAME 

DEPARTMENT NAME 
Light 

Blue -- 4 1 

CG Times. 

Horizontally center. 

Vertically middle 

6 First Angle Symbol 

Øԁ = 9 

Black 
0.5 -- -- 

Line font-SOLID 

FONT,CTRL FONT 

7 Note-ALL 

DIMENSIONS ARE IN 

MM 

Dark 

Blue -- 4 1 
CG Times 
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Following steps are required to create an A4 sized landscape custom based template 

format.  (Here you can use any CAD software) 

 

A. Setting the Environment: 

1. Click on   icon on the desktop. The software will be launched, and the first  

       window will be displayed as shown in Figure. 

 
B. Set working directory: 

To store all the created work content (files) in the current session in a specified folder; 

initially we have to set the directory. You can set any existing folder as the working 

directory. To do this, click File>Manage Session>SelectWorking Directory, select 

the particular folder.  

 

 
 

After setting specified directory the screen will appear as shown in Figure. 
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Click OK as shown in Figure. 

 

C. To invoke format environment: 

1.  Select New from the File toolbar. The New dialog box is display. 

2. Select the format radio button. 

3. Type name as PRACTICAL1_TEMPLETE_FORMAT.  

4. Choose the OK button. 

 
  

                   When you invoke the Format mode, the new dialog box will display shown in  

                    Figure. 
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1. Select the Empty radio button. Select landscape orientation.  

2. Specify A4 (297X210 mm) size sheet by drop down menu.  

3. Click on OK.The A4 size sheet will appear as shown in Figure. 

 

 
 

D. To draw border 10 mm inside the sheet: 

1. Select Sketch from ribbon menu to draw border to the sheet. 

2. Select Offset Edge command from sketching tool bar. 

3. Select Ent. Chain from menu manager. 

4. Select the A4 size sheet by pressing Ctrl button of key board.  

5. Click OK from‘select’ dialog box.  
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6. Enter off set distance -10 and accept the value.Exit from commands. 

 

               Figure show the A4 size sheet with 10 mm border inside the sheet. 

 
E. Toinsert the table. 

1. Choose Table from ribbon menu. 

2. Select the table by specifying 3 columns and 5 rows as shown in  

   Figure. 

3. Click curser inside the border of A4 size sheet. 

 
  The table will display on the drawing area as shown in Figure. 

 
 

F. To convert the table to required height and width: 

1. Highlight the table by window selection method.  

2. Click to Height and width tool option .The new Height and  

     Width definition dialog box will appear on the screen as shown in figure. 
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In the same dialog box- 

1. Uncheck the ‘Automatic height adjustment’ option. 

2. Mention the height 10 and width 50 in the same dialog box option. 

3. Click OK, Click the cursor in drawing area. 

 

The table appearance is similar to the one shown in Figure. 

 
 

G. To merge the required cell: 

1. Highlight the cells, those you want to merge by pressing Ctrl button of key board. 

2. Click on Merge Cells options from menu bar. 

3. Click the cursor in drawing area. 

       The table appearance is similar to the one shown in Figure. 

 
 

         Repeat the same procedure to merge remaining cell as per sample title block given to  

         you. 

H.   To move entire table to lower right corner of the border : 

1. Click on Table from menu bar. 

2. Highlight table by clicking on it. 

3. Pick up the table Grib and locate it at lower left corner of border. 

The table will look like as shown in Figure. 
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I. To add the text as per the given sample title block: 

1. Highlight a cell by double clicking. 

2. New ‘Note properties’ definition dialog box will open. 

 

 
3. Type the text ‘NAME-' in note properties window as shown. 

 
4. Select the Text Style tab from same window. 

5. Mention Height 4, thickness 1, font CG TIMES, left, middle and red color for  

     proper alignment of letter. Click on Preview and OK tab. 

 

The same screen will look appear as shown in Figure. 

 

 
6. Repeat the same procedure for all letters. 

Finally you will get the TITLE BLOCK as shown in Figure. 
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J. To change table line width and color: 

1. Select Table>Select Line Style option button. 

2. Keep Modify Lines as default as it is. 

 
3. Select table of name plate by just clicking. 

4. Select OK  

5. New Modify Line Styledefinition dialog box will appear on screen. 

 
6. Enter required width 0.5 and brown color and click on Apply button. 

 

     The table line width will get changed and appear is similar to the one shown in 

Figure. 
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K. To change line width and color of border lines: 

1. Select Sketcher> Line Style> Modify Lines. 

2. Then select entire border lines by pressing Ctrl button of key board.  

3. Accept your selection by clicking OK 

 
 

               New Modify Line Style definition dialog box will appear on screen. 

 

 
 4. Enter the width by 1 and black color. Click to Apply> Close>OK 

                 The border line width will get changed and appear is similar to the one shown in                                

                 Figure. 
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L. To createFIRST ANGLE symbol in template: 

1. Select Annotate from menu bar. 

2. Select Symbol Gallery from Symbol drops down list. 

 

3. Select Define from Menu Manager. 

4. Specify symbol name as FIRST_ANGLE and accept selection. 

 
The next new screen will appear shown in Figure. 

 
To draw first angle projection symbol. Use tool bar shown in previous Figure. 

1. Select Sketcher>Line 

 
2. Start to draw symbol. First you have to draw horizontal and vertical lines.  

3. Change line style by selecting line and click RMB. Select Line Style. 

 
New Modify Line Styledefinition dialog box will appear on screen. 
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4. Select CTRL FONT and Blackcolor. Click to Apply button. 

 
Continue the same procedure whenever you want to change the line style. 

5. Next insert Point at intersection of two center lines as shown in Figure. 

 
6. Draw two circles of diameter 9 and 4.5 by using Edit Diameter Value by right 

clicking option and accept it by clicking as shown in Figure. 

 
 

              You have to draw remaining entities of symbol according to proportionate  

               mention in Figure. Finally First Angle symbol will look like as shown in Figure.  

 
       To change symbol width. 

1. Select symbol by window method. 

2. Right click and choose Line Style option. 

3. Specify width by 0.5 as shown in Figure. Click Applybutton. 
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4. The symbol line width will change as shown in Figure. Next click on Done 

from the Menu manager. 

 
 

            New window Symbol Definition Attribute dialog boxwill display on the screen  

            as shown in Figure. 

5. Tick the Free option and click on OK. 

 
 

            New Select Point definition dialog box will open.  

6. Select a point using absolute co-ordinates option. Click on OK 

 
                 Again window Symbol Definition Attribute will display on the screen.Click  

                on OK. 
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7. Select Done option from Menu Manager. 

 
 

               Now you will be at main screen as shown in Figure. 

 
8. Select Done option from Menu Manager. 

               First Angle symbol is created in Custom Symbol. 

 

M. To insert prepared first angle projection symbol in name plate: 

1. Select Annotate> Symbol>Custom Symbol from menu bar. 

 
 

                New Custom Drawing Symbol window will display on screen. 
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2. Select FIRST_ANGLE as the symbol name from the list as shown in Figure. 

 
3. Now click on actual symbol and place it in drawing area by moving cursor as 

shown in Figure. Click on OK. 

 
4. Move the symbol at required position. 

 
                    Finally sheet with symbol will look like as shown in Figure. 
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N. To add note without leader: 

1.  Click Annotate tab, select Note button Note and click Make Note options 

from Menu Manager. 

 
             New Select Point window will appear on the screen. 

1. Choose Free point and locate it as per requirement. 

 
2. Write note as ALL DIMENSIONS ARE IN MM and accept it. 

3. Select Done from Menu Manager. 

 
4. Right click on letters you written. Select Properties option.  

 

 

 

 

 

                   Note Properties window will open. 
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5. Specify font as CG Times, Height 4, Thickness 1, blue color. Select 

Preview. Click OK button. Finally mentioned note will look like as shown 

in Figure. 

 

O. To change sheet name Lines & Lettering by SCREW JACK ASSEMBLY: 

1. Double click to respective cell. Note Properties window will display. 

 
2. Type SCREW JACK ASSEMBY in Text option. 

 
3. Select Text Style tab, and enter the font-4, Thickness -1, horizontally center and 

vertically middle alignment. Color –green. 

 
4. Click Preview and OK. 

 

             Finally the A4 size landscape custom based template format will ready as  

             shown in Figure. 
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P. Save the work by clicking the Save button. The A4 size custom based template 

format stored in working directory and we can use it for further work. 

 

XII Resources Used  

 

S. 

No. 

Name of 

Resource 

Broad Specifications 
Quantity 

Remarks 

(If any) Make Details 

1.       

2.       

3.       

 

 

XIII Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIV Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  
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XV Observations and Calculations 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XVI Results 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XVII Interpretation of Results  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XVIII Course proficiency 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIX Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions so as to ensure the achievement of identified CO. 

 

1. List the different menu bar used in software. 

2. Write the purpose of Title block in drawing sheet. 

3. Explain information mention in title block. 

 

[Space for Answer] 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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XX References / Suggestions for Further Reading 

o https://www.youtube.com/watch?v=B96jGGkt-zk 

o https://www.youtube.com/watch?v=cWCI8Klji80    

o https://www.youtube.com/watch?v=zJrea53xtG8 

 

XXI Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) 40% 

1  Use of proper commands.   20% 

2  Completion of drawing with minimum size of 

model tree. 
20% 

Product Related (15 Marks) 60% 

3  Generation and printing of drawing views, tables, 

etc. and their arrangement on different sheet size. 
20% 

4  Able to answer oral questions. 20% 

5  Completion of work in time.  20% 

Total (25 Marks) 100 % 

 

           Names of Student Team Members 

1. ……………………….. 

2. ……………………….. 

3. ………………………… 

 

 

 

 

 

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.youtube.com/watch?v=B96jGGkt-zk
https://www.youtube.com/watch?v=zJrea53xtG8
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Practical No.2: Draw and print two simple 2D geometries using sketcher 

commands. 

 
I. Practical Significance 

To create a 3D feature, it is necessary to draw its 2D sketch. In the sketcher 

environment the sketch of the feature is created, dimensions and constrains are 

provided to sketch. The designer can make to make sure that the 2D sketch of the 

product is satisfying the necessary conditions, then continue to create 3D model of the 

product in the part mode. 

 

II. Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and 

allied industry.  

 

III.  Competency and Skills 

This practical is expected to develop the following skills for the industry identified 

competency ‘Apply different sketcher environment commands to draw 2D 

geometries of the modeling software, apply various constrains and dimensioning to 

the 2D sketch’  

 

IV.  Relevant Course Outcome(s) 

 Prepare 2D Drawings using sketcher workbench of any Parametric Modeling 

software. 

 

V.  Practical Outcome 

 Operate available modeling software to draw 2D sketch for engineering product. 

 

VI.  Relative Affective Domain- 

 Working in team work. 

 Follow ethical Practices. 

 

VII. Minimum Theoretical Background 

 Basic knowledge of computer handling. 

 Basic knowledge geometric constructions. 

 Reading of engineering drawing. 

 Basic knowledge of sketcher environment. 
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The sketcher environment - 

Sketcher is the main creation tool ofparametric CAD software. The sketcher toolbar ribbon is 

located at the top of the window. This section explores the many options of sketcher. Its basic 

icons are shown in Figure. The LMB (Left Mouse Button) issued to select geometry or to 

select a location when creating geometry. When you invoke the Sketch mode, the initial 

screen appearance is similar to the one shown in Figure. This figure shows the Sketcher 

Tools as well as Setup, Get Data, Operations, Datum, Editing, Constrain, Dimension, and 

Inspect etc. toolbars displayed at the top side of the graphics window.  

 

 
Reminder: 

LMB = press the Left Mouse Button down, used to select points or features. 

RMB = press the Right Mouse Button down, used to search through a series of features or 

used to bring up a pop-up menu.MMB = press the Middle Mouse Button down, used to cancel 

a command, place a dimension, or accept the current value. 

 

Sketcher Tools Explained: 

Now let’s explain most of the sketcher icons. It is important to note that the LMBactivates 

each of the sketcher tools. 

 
1 Setup: 

Allows you to reset the sketch plane and references, sketching options, and to reorient your 

view (note this button is also on the Graphics toolbar). 

 

Tool Name Symbol Use 

Setup Tool Bar 

Grid 

 

Define the grid settings. 

2 Operations: 

Operations Tool Bar 

Tool 

Name 
Symbols Use 

 

 

 

Select 

 

Select Items tool allows you to select features already on the 

screen by moving the cursor over the item, then pressing the 

LMB. 

 

Select one by one entity. For next entity selection press Ctrl 

and then click the entities.  

 

Select the chain of entities. 
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Select all Geometry entities. 

 
Select all items the drawn section. 

 

Datum Tool Bar 

Tool 

Name 
Symbol Use 

Centerline 

 

Draw an infinitely long geometric centerline byselecting two points 

with the LMB. 

Points 

 
 

Create a geometry point using the LMB. 

 

Sketching Tool Bar 

Tool Name Symbol Use 

Line Chain 
 

Draw a solid line from first LMB pick location to secondLMB 

location pick. 

Constructi

on Mode 
 

Toggle button is used to draw sketch in either geometry mode or 

construction mode. 

Line 

Tangent 
 

Draw a solid line tangent between two arcs or circles, whichare 

selected using the LMB. 

Corner 

Rectangle 
 

Sketch a rectangle by selecting two opposite corners of the rectangle 

using the LMB. 

Slanted 

Rectangle  

Sketch a slanted rectangle by sketching one side of the slanted 

rectangle using the LMB twice, and then moving perpendicular to 

this side to create the slanted rectangle’s size. 

Center 

Rectangle 
 

Sketch a rectangle by selecting the center point of the rectangle, then 

one of its four corners using the LMB 

Parallelogr

am  

Sketch a parallelogram by sketching one side of the parallelogram 

using the LMB twice, and then moving away from this side to create 

the parallelogram’s shape. 

Center and 

Point 

Circle 
 

Draw a circle by selecting the location of the circle’s center with the 

LMB, then moving away from that point to create its radius. 

Concentric 

Circle  

Draw a new circle using the same center point as an existing circle. 

First the existing circle must be selected with the LMB, and then a 

new circle appears. 

3-Point 

Circle 
 

Draw a circle through three points which are selected by pressing 

the LMB three times. 

3-Tangent 

Circle 
 

Draw a circle tangent to three features which are selected by pressing the 

LMB three times. 

3-

Point/Tang

ent End 

Arc 

 

Draw a circular (constant radius) arc by selecting its two endpoints 

using the LMB, then moving the cursor to size the arc’s radius or 

make one end of the arc tangent to an existing feature. plus sign (+) 

will appear at the center of the arc. 
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Center and 

Ends Arc  

Draw a circular (constant radius) arc by first selecting its center 

point using the LMB, then moving the cursor to size the arc’s radius. 

Pressing the LMB sets the arc’s radius. 

3-Tangent 

Arc  

Draw an arc tangent to three other features. 

Concentric 

Arc  

Draw a concentric arc using the same center point asan existing 

circle or arc. 

Conic Arc 
 

Draw a conic (variable radius) arc by selecting its two endpoints 

using the LMB, then moving the cursor to size the conic arc. 

Axis Ends 

Ellipse  

Draw an ellipse by selecting the end points of the major or minor 

axis, then moving perpendicular to this axis to size the other axis. 

Center and 

Axis 

Ellipse 
 

Draw an ellipse by selecting its center usingLMB, one end of its 

major or minor axis using LMB, then moving perpendicular to this 

axis to size the other axis. 

Spline 
 

Draw a free-hand spline curve by selecting spline points using the 

LMB. 

Circular 

Fillet  

Draw a circular fillet or round tangent to two features. 

Circular 

Trim Fillet  

Draw a circular fillet or round tangent to two features. 

Elliptical 

Fillet 
 

Draw an elliptical fillet or round tangent to two featuresat the two 

points selected on the features using the LMB. 

Elliptical 

Trim Fillet 
 

Draw an elliptical fillet or round tangent to two features at the two 

points selected on the features using the LMB. 

Chamfer 

Fillet  

Draw a chamfer between two intersecting lines starting at the points 

selected using the LMB, then remove the line segments in the area 

of the intersection of the two lines. 

Chamfer 

Trim Fillet  

Draw a chamfer between two intersecting lines starting at the points 

selected using the LMB, then remove the line segments in the area 

of the intersection of the two lines. 

Offset 
 

Create duplicate geometry an offset distance from the selected 

geometry. 

Thicken 
 

Create entities by offsetting an edge or a sketched entity ontwo 

sides. 

Text 
 

Create alpha characters and symbols on the sketch. 

Text Along 

A Curve  

To place text along a curve create the start and height points as 

before, then check the “Place along curve” box  followed by 

selecting the curve to follow using the LMB. 

Palette 
 

Provides you with a customizable library of predefined shapes that 

you can readily import onto the active sketch plane. These shapes 

are presented in a palette. 

Construction 

Centerline 
 

Draw an infinitely long sketcher centerline by selecting two points 

with the LMB. 



Solid Modelling and Additive Manufacturing (22053) 

 27 

Construction 

Centerline 

Tangent  

Draw an infinitely long sketcher centerline tangent to two circles or 

arcs using the LMB. 

Construction 

Point 
 

Create a construction point using the LMB. This point is known 

only inside sketcher and is not visible outside sketcher. 

Construction 

Coordinate 

System  

Create a construction coordinate system at the specified point by 

pressing the LMB. 

 

 

 

Editing Tool Bar 

Tool 

Name 
Symbol Use 

Modify 
 

The common way is to highlight the dimensions to be modified 

using the LMB for the first. The second way is to select the tool 

first, then select a dimension to be modified using the LMB. 

Mirror 
 

Mirror a selection of features about a specified centerline, thus 

there must be a centerline present in the sketch. 

Divide 

Entity at 

This Point  

Divide a feature at the point of selection located by pressing the 

LMB. This will break a straight or curved line segment into two 

parts. 

Delete 

Segment 
 

Will remove any line segment that is drawn through while 

holding down the LMB. 

Corner 

 

This tool is used to trim the intersection of two line segments 

back to the intersection point. 

 

Constraint Tool Bar 

Tool Name Symbol Use 

Vertical 

Constraint 
 

Force the selected line to be vertical. After selecting this tool, 

select the desired line using the LMB. 

Horizontal 

Constraint 
 

Force the selected line to be horizontal. After selecting this tool, 

select the desired line using the LMB. 

Perpendicular 

Constraint 
 

Force two selected lines to be perpendicular to each other. After 

selecting the tool, select the two lines using the LMB. 

Tangent 

Constraint 
 

Force a line, an arc, or a circle to be tangent to an arc or a circle. 

After selecting the tool, select the two features using the LMB. 

Mid-point 

Constraint  

Force a point to locate itself at the midpoint of a line segment or 

arc. After selecting the tool, select the approximate location of 

the. Midpoint using the LMB, then select the line segment or arc 

using the LMB. 

Coincident 

Constraint 
 

Make two points coincident, that is, the exact same point. After 

selecting the tool, select the two points using the LMB. 

Symmetric 

Constraint  

Force two points to be symmetric about the selected centerline. 

There must be a centerline present to use this command. After 

the tool is selected, pick the governing centerline using the 
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LMB, then select the two points (one on each side of the 

centerline) using the LMB. 

Equal 

Constraint 
 

Force two or more features to be equal size. After the tool is 

selected, select the governing feature (line length or radius) 

using the LMB,then using the LMB select all features that you 

want to be the exact same size. 

Parallel 

Constraint 
 

Force two lines to be parallel. After the tool is selected, select 

the governing line segment using the LMB, then using the 

LMBselect all other line segments that you want to be the 

parallel to the governing line segment. 

 

Dimension Tool Bar 

Tool Name Symbol Use 

Normal 

Dimension 
 

Add a strong dimension to the existing sketch. 

Perimeter 
 

Add a perimeter dimension to the sketch after selecting a 

dimension which can vary when the perimeter dimension is 

modified. 

Baseline 
 

Create an ordinate dimension baseline, either vertical or 

horizontal. 

Reference 

Dimension  

Add a reference (driven by other values) dimension to the 

existing sketch. Reference dimensions are added the same way 

as regular dimensions. 

 

Inspect Tool Bar 

Tool Name Symbol Use 

Overlapping 

Geometry 
 

Pick the Overlapping Geometry icon to highlight the sketcher 

geometry that overlaps so that you can correct the problem. 

Highlight 

Open Ends 

 

Pick the Highlight Open Ends icon to highlight using green dots, 

the line segments that are not connected to anything, thus they 

are open ends. 

Shade Closed 

Loops 

 

Pick the Shade Closed Loops icon to fill in all closed figures so 

you can see which sections of your sketch are not closed for one 

reason or another. 

 

Close Sketcher from Part Mode 

Tool Name Symbol Use 

Accept 

 

Accept the changes made in the sketcher and exit sketcher. 

Cancel 

 

Cancel the changes made in sketcher and exit sketcher. 

 

 

Sketcher Graphics Tool Bar 

Refit 

 

Adjust the zoom level to fully display the object on the screen. 
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Zoom In 

 

Zoom in on target geometry to view it in greater detail. 

Zoom Out 

 

Zoom out to gain a wider perspective on the geometry. 

Repaint 

 

Redraw the current view (refresh). 

Sketcher 

display filter 

 

Define sketcher display. 

Select All 

 

To display all sketcher display. 

Disp.Dims. 
 

To display dimensions. 

Disp.Constr. 
 

To display constraints. 

Disp.Grid. 
 

To display grid. 

Disp.Verts 
 

To display vertices. 

 

VIII. Experimental setup  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

IX.  Resources Required 
 

S. 

No. 

Name of Resource Suggested Broad Specification Quantity 

 

1 

Hardware: Personal 

computer. 

 (i5 or higher), RAM minimum 4 GB; 

A3 / A4 size printer / plotter. Display-

wide Screen preferably. 

As  per 

batch 

size 

 

2 

 

Operating system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 

As  per 

batch 

size 

 

3 

 

Software 

Any parametric solid modeling 

software. 

As  per 

batch 

size 

4 Plotter Plotter A2 OR A3Size. 1 

 

 

X.  Precautions to be Followed 

1. Check given drawing for dimensional printing mistakes if any and if dimensions 

are missing assume proportionate dimensions.  

2. While constructing the drawing, periodically save your work.  
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XI.  Procedure- 

Exercise No.1-Rerdaw the given 2D geometries.  

(Use Grid and snap to grid option) 

 
 

Following steps are required to sketch the given 2D geometries in available software. 

(Here you can use any CAD software) 

A. Setting the Environment: As explained in practical No. 01. 

B. Set working directory: As explained in practical No. 01. 

C. To invoke sketcher environment- by either selecting File>New from the menu or 

click on the New File icon from the main toolbar. A new window will be displayed as 

shown in Figure by default. Select Sketch option from the same window  to sketch the 

drawing.Type name as PRACTICAL2_EXERCISE1.Click OK button. 

 
Now you will be in the sketcher environment of the sketch as shown in Figure to 

sketch the 2D geometries. 
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D. To sketch given 2D geometries- 

1. Initially set the sketcher workbench by invoking File >Options which display a  

    Solid Modeling Parametric Options window as shown in Figure. 

 
2. By selecting Sketcher from the list of the same window, you can check on show  

     the Grid andSnap to grid. Also set the Number of decimal places for  

     dimension-2. As shown in Figure. 

 
3. Now click OK button. The screen will look like as shown in Figure.  

4. To set the X-spacing and Y-spacing for current exercise, follow the following  

      procedure.  

 

5. Click on Grid icon and specify the X& Y spacing is as 5 units as shown  

     in Figure. Then click OK button of same window. Selection of grid lines helps to  

    draw entities easily.  
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6. Choose Line button from the sketcher tool bar. Click LMB on the drawing area 

and move the cursor left by 2 grid units to draw line of 10 units long as per the given 

drawing. When the cursor is moved horizontally left, horizontal constraint will applied 

automatically to the line as shown in Figure. Press LMB. 

 
7. Continue the same procedure till the point as shown in Figure. 

8. Now draw the arc by selecting Arc >Center and End  option as shown in Figure.

 
9. In similar manner complete the entire close loop drawing as shown in Figure. 

 
10. Press the MMB. Weak dimensions will display on the sketch as shown in Figure. 
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E. Modify the Dimensions: 

1. To modify a dimension by double-clicking on its value using the LMB, and then 

type a new value as per the drawing. 

2. Use Normal Dimension option to provide additional dimensions if required 

by resolving other dimensions. 

3. You can also use Modify Dimensions to change the dimensions. 

4. Continue the same procedure for sketching square inside the drawing. In this way, 

all sketch dimensions is changed as per the given drawing as shown in Figure 

 
 

F. ClickSave button which saves sketch by PACTICAL2_EXERCISE1with .sec file ext. 

 

G. Print the created sketch in MS Word by Print Screen Shot.   
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           Exercise No.2-Rerdaw the given 2D geometries using sketcher  

                                   workbench.(Without Grid) 

 

 
 

1. To invoke sketcher environment-As explained in practical No.2, exercise 1.Type 

name as PRACTICAL2_EXERCISE2.Click OK button.  

2. Now you will be in the sketcher environment of the sketch as shown in Figure to 

sketch the 2D geometries. 

 

3. Draw the center lines, circle center points as shown in figure.  

4. To modify a dimension by double-clicking on its value using the LMB, and then type 

a new value as per the drawing. 

5. You can use Modify option to change the dimensions as shown in Figure. 

 
6. Draw internal circles of given diameters at different center pointsas shown below by 

using Circle command from sketching tool bar. 
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7. Draw the outer circles at the same center points using  commands as per 

given dimensions.  

 

8. Draw tangent lines to outer circles by using Line Tangent command from 

sketching tool bar as per the given drawing. 

 

9. Trim the unwanted parts of circles by using Trim command from editing tool 

bar. 
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10. Give the fillets at respective position by using Circular Trim command 

from sketching tool bar and complete the sketch as shown in Figure. 

 
 

11. ClickSave button which saves sketch by PACTICAL2_EXERCISE2inworking 

directory with .sec file extension. 

 

12. Print the created sketch in MS Word by Print Screen Shot.   
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XII. Resources Used  

 

S. 

No 

Name of 

Resource 

Broad Specifications 
Quantity 

Remarks 

(If any) Make Details 

1.       

2.       

3.       

 

XIII. Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIV. Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XV. Course proficiency 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XVI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

1. Explain purpose of working directory in software. 

2. Enlist sketcher toolbar to draw basic 2D entities. 

 

[Space for Answer] 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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XVII. Questions for Practice. 

.  

 

 

 

XVIII. References / Suggestions for Further Reading 

 https://www.youtube.com/watch?v=lpH4ZUUD9N0 

 https://www.youtube.com/watch?v=qFIev5cRlW4 

 https://www.youtube.com/watch?v=lpH4ZUUD9N0 

 https://www.youtube.com/watch?v=sVWsUS_7V6s&list=PLrOFa8sDv6jfVMc

cV28fssFut0EG0NNb6 

 

XIX. Assessment Scheme 

Performance Indicators Weightage 

Process Related (10 Marks) 40% 

1  Use of proper commands.   20% 

2 Completion of drawing with minimum size of 

model tree. 
20% 

Product Related (15 Marks) 60% 

3 Generation and printing of drawing views, tables, 

etc. and their arrangement on different sheet size. 
20% 

4 Able to answer oral questions. 20% 

5 Completion of work in time.  20% 

Total (25 Marks) 100 % 

 

Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………. 

4. ……………………….. 

 

 

 

 

 

 

 

 

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=video&cd=5&ved=0ahUKEwikx5Xp2MzgAhXHdCsKHZtCDAMQtwIINzAE&url=https%3A%2F%2Fwww.youtube.com%2Fwatch%3Fv%3DlpH4ZUUD9N0&usg=AOvVaw0k0cjQof8YnbLTkBt8Xj__
https://www.youtube.com/watch?v=qFIev5cRlW4
https://www.youtube.com/watch?v=lpH4ZUUD9N0
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Practical No.3: Draw and print two given complex 2D geometries 

using sketcher commands. 

 

I. Practical Significance 

To create a 3D feature, it is necessary to draw its 2D sketch. In the sketcher 

environment the sketch of the feature is created, dimensions and constrains are 

provided to sketch. The designer can make to make sure that the 2D sketch of the 

product is satisfying the necessary conditions, then continue to create 3D model of the 

product in the part mode. 

 

II.  Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and allied 

industry.  

 

III. Competency and Skills 

This practical is expected to develop the following skills for the industry identified 

competency ‘Apply different sketcher environment commands to draw 2D 

geometries of the modeling software, apply various constrains and dimensioning to 

the 2D sketch’  

 

IV. Relevant Course Outcome(s) 

 Prepare 2D Drawings using sketcher workbench of any parametric modeling 

software. 

 

V. Practical Outcome 

 Operate available modeling software to draw 2D sketch for engineering product. 

 

VI. Relative Affective Domain 

 Working in team work. 

 Follow ethical practices. 

 

VII. Minimum Theoretical Background 

 Reading of engineering drawing. 

 Basic knowledge of CAD software and commands. 
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VIII. Resources Required 
 

S. No. Name of Resource Suggested Broad Specification Quantity 

 

1 

 

Hardware: Personal 

computer. 

 (i5 or higher), RAM minimum 4 GB; 

A3 / A4 size printer / plotter. Display-

wide Screen preferably. 

As  per 

batch 

size 

 

2 

 

Operating system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 

As  per 

batch 

size 

 

3 

 

Software 

Any parametric solid modeling 

software. 

As  per 

batch 

size 

4 Plotter Plotter A2 OR A3 Size. 1 

 

IX. Experimental setup  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

X. Precautions to be Followed 

1. Check given drawing for dimensional printing mistakes if any and if dimensions 

are missing assume proportionate dimensions.  

2. While constructing the drawing, periodically save your work.  

 

XI. Procedure- 

Exercise No.1-Redraw the following given 2D geometries using sketcher 

workbench as shown in Figure. 

 

 
          Following steps are required to sketch the given 2D geometries. 
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A. Start Solid Modeling Parametric CAD software: As explained in practical No. 01. 

B. Set working directory: As explained in practical No. 01. 

C. To create sketcher environment: As explainedin practical No.02. 

1 Type name as PRACTICAL3_EXERCISE1.Click OK button.  

 
Now you will be in the sketcher environment as shown in Figure to sketch the 2D 

geometries. 

 
D. To sketch given 2D geometries: 

1. Initially set the sketcher workbench by invoking File > Optionswhich display a 

Solid Modeling Parametric Options window as shown in Figure.  

 
2. By selecting Sketcher from the list of the same window, specify the number of 

decimal places for dimension. For the current exercise, 2 decimal places for 

dimension needed. As shown in Figure. 
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3. Now click OK button. The screen will look like as shown in Figure.

 

4 Use Centerlineoption to draw vertical and horizontal centerlines. 

5 To modify a dimension bydouble-clickon its value using the LMB, and then type a 

new value as per the drawing. 

6 Draw one more center line inclined at an angle 51º using same procedure. 

7 Use Point option to locate the center point of the circles. 

8 Use Concentric option to draw circles of different diameter as per the 

given drawing. 

9 To modify a dimension of the circle by double-clickon its value using the LMB, 

and then type a new value Ø 30,60,100,80,15,44,50,25 & 21 as per the drawing. 
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10 To draw tangent lines to the circles. Use LineTangent 

option.Click Line>Line Tangent button, and select the tangent point of first 

circle and tangent point of second circle as shown in Figure. Continue the 

same procedure to draw four tangent lines. 

 
11 To draw lines parallel to the tangent lines as shown in above Figure, Choose 

Line button from sketcher tool bar. Pick the first and second point 

near to the tangent line. Continue the same procedure for next parallel line. 

Press MMB to exit.(Here parallel constraint is applied automatically) 

12 To modify a dimension of the parallel lines by double-click on its value using 

the LMB, and then type a new value 10 mm as per the drawing. 

 

 

1.
 

To draw fillet of 5 mm. Use Fillet from sketcher tool bar. Click 

Fillet>Circular Trim. Select line as first entity and Ø 60 circle as second entity. 

Repeat the same procedure for all fillets as shown in Figure. 

2.
 

To modify a dimension of the fillet radius by double-click on its value using the LMB, 

and then type a new value 5mmas per the drawing. 
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3. To trim unwanted lines, use Delete Segment option of editing tool 

bar. Click on the Delete Segment button and then choose unwanted lines one by one 

as shown in Figure. 

 
 

4. Use Mirror option from the editing tool bar to mirror fillet and line. Click 

 button, select all entities to be mirrored by keep holding Ctrl key board 

button and select entities to be mirrored one by one. Once the selection complete, 

release Ctrl button and click center line. The selected entities will get mirrored as 

shown in Figure.   
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5. To trim unwanted lines, use Delete Segmentoption of editing tool 

bar. Click on the Delete Segmentbutton and then choose unwanted 

lines one by one as shown in Figure. Draw 3 x 7 on 30 PCD as per the given 

drawing.  

6. Use Shade Closed Loop button in active mode to appear shaded closed loop 

portion as shown in Figure. 
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7. Use Sketcher Display Filter option to see final sketch as shown in 

Figure. 

 
E. Click Save button which saves sketch by PACTICAL3_EXERCISE1 with .sec file 

extension. 

 Exercise No.2-Rerdaw the given 2D geometries using sketcher workbench as shown  

in Figure. 

 
        Following steps are required to sketch the given 2D geometries. 

A. Start Solid modeling Parametric: As explained in practical No.01. 

B. Set working directory: As explained in practical No.01. 

C. To create sketcher environment: As explained in practical No.02. 

1 Type name as PRACTICAL3_EXERCISE2.Click OK button.  

2 Now you will be in the sketcher environment to draw sketch the 2D  

     geometries. 
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D. To sketch given 2D geometries: 

1. Initially set the sketcher workbench by invoking File >Options which display 

solid modeling parametric options window as shown in Figure. 

 
2. By selecting Sketcheroptionfrom the list of the same window. 

3. Specify the number of decimal places for dimension. For the current exercise, 3 

decimal places of dimension needed. As shown in Figure.  

 
4. Now click OK button. The screen will look like as shown in Figure. Now you are in 

sketcher environment to draw the given sketch. 

5. Use Centerlineoptionsto draw vertical and horizontal centerlines. 

6. To draw 5 vertical center lines, Select  and click first point and second point 

vertically. Continue the same procedure for next vertical centerlines. 

7. To draw 2 horizontal centerlines, continue the same procedure clicking two points 

horizontally for each center line. 

8. Draw one more center line inclined at an angle 40º using same procedure. 

9. To modify a linear and angular dimension of centerlines, double-click on its value 

using the LMB, and then type a new value according to given drawing. 

10. Use  to locate the center point of the circles. 

11. Use Concentric option to draw circles of different diameter as per the 

given drawing. 
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12. To modify a dimension of circles, double-click on its value using the LMB, and then 

type a new value according to given drawing. 

 

 

13. To draw elongated cylindrical hole, use Palette tool. Click on 

Palette icon. Palette sketcher window will appear on the screen.  

14. Select Arc racetrack from the Shapes option. Drag it in drawing area as shown in 

Figure. 

 
15. To rotate it by 180º, enter 180 values. 

 
16.  Accept by clicking on green colored check window as shown in Figure. 
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17.   To modify a dimension of arc racetrack by double-click on its value using the LMB, 

and then type a new value according to given drawing. 

18. To locate arc racetrack to correct position as per the given drawing. Use

Coincident tool from the sketcher tool bar. 

19. First select coincident button from sketcher tool bar. Then select first point as 

center point of the circle R 2.312 and second point will be center point of arc 

racetrack. 

20. Similarly coincide the remaining two points of arc racetrack with respect to circle 

R2.312.Out of that one point will be coincident to intersection of point of the circle 

radius R2.312 and center line which making an angle 40º with horizontal center line. 

The second point will be coincident to intersection of point of the circle R 2.312 and 

horizontal center line of the circleR 2.312. 

21. To draw elongate hole, use Palette tool. Click on Palette icon. 

Palette sketcher window will appear on the screen. Select racetrack from the Shapes 

option. Drag it in drawing area as shown in Figure. 

22. Accept it by clicking on green colored check window as shown in Figure. 

 
23. To modify a dimension of racetrack by double-clickon its value using the LMB, and 

then type a new value according to given drawing. 

24. To locate racetrack to correct position as per the given drawing. Use

Coincidenttool from the sketcher tool bar. 

25. First select  button from sketcher tool bar. Applying same method explained 

earlier case to coincident the two points of racetrack with the main sketch as shown in 

Figure. 



Solid Modelling and Additive Manufacturing (22053) 

 51 

 

26. To Offset the arc racetrack by 0.437 and offset race track by 0.313 using 

Offset tool.  

27. Click on offset from sketcher tool bar and select entity to be offset. 

28. Select loop option. Enter off set distance 0.437 for arc racetrack. Accept 

the entered value. Continue the same procedure for racetrack as shown in Figure. 

 



Solid Modelling and Additive Manufacturing (22053) 

 52 

 

29. To draw the tangent circles. Use Tangent constraint tool from constrain tool 

bar. 

30. First draw circle using  tool. Take care that drawn circle should not be 

touch to any other entity. 

31. Modify a dimension of above circle by double-click on its value using the LMB, and 

then type a new value R1.750  according to given drawing. 

32. To tangent the circleR1.750 and circleØ1.625.Click on Tangent tool from 

constraint tool bar. Then select the circle R1.750 and circle Ø1.625. 

33. To tangent the circleR1.750 and outer racetrack of R 0.750. As the in selected 

mode. Select first the circleR1.750 and then select outer racetrack of R 0.750. As 

shown in Figure. 
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34. Now we have to draw a tangent circle to circle of Ø1.625 and to the outer racetrack of 

R 0.875 from upper side of the drawing. 

35. First draw circle using  tool. Take care that drawn circle should not touch 

to any other entity. 

36. Modify a dimension of above circle by double-clickon its value using the LMB, and 

then type a new value R 0.625 according to given drawing. 

37. To tangent the circle Ø1.625 and circle R 0. 625.Click on Tangent tool from 

constraint tool bar. Then select the first circle Ø1.625and then select circle R 0. 625. 

38. To tangent the circleR 0.625 and outer racetrack of R 0.875. As the in selected 

mode. Select first the circleR 0.625 and then select outer racetrack R 0.875.As shown 

in Figure. 

 
39. Now we have to draw tangent circle to the circle R1.375 and racetrack of R 0.875 

from lower side of the sketch. 

40. First draw circle using  tool. Take care that drawn circle should not touch 

to any other entity. 

41. Modify a dimension of above circle by double-click on its value using the LMB, and 

then type a new value R 0.625according to given drawing. 

42. To tangent the circle R1.375 and circle R 0. 625.Click on Tangent tool from 

constraint tool bar. Then select the first circle R1.375 and then select circle R 0. 625. 

43. To tangent the circleR 0.625 and outer racetrack of R 0.875. As the in selected 

mode. Select first the circleR 0.625 and then select outer racetrack R 0.875.As shown 

in Figure. 
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44. We have to draw the tangent line to circle R1.375 and to the outer racetrack of R 0.750 

from lower side of the drawing. 

45. To draw tangent lines to the circlesR1.375 andto the outer racetrack of R 0.750. Use 

Line Tangentoption. ClickLine >Line Tangent button, and select the 

tangent point of first circleR1.375 and then select tangent point of theouter racetrack 

of R 0.750. As shown in Figure.  

 

 

46. To trim unwanted lines, use  option of editing tool bar. Click on the 

Delete Segmentbutton and then choose unwanted lines one by one 

as shown in Figure. 
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47. To trim unwanted lines, use  option of editing tool bar. Click on the 

Delete Segmentbutton and then choose unwanted lines one by one 

as shown in Figure. 

48. Use Shade Closed Loop button in active mode to appear shaded closed loop 

portion as shown in Figure. 

 
E. Finally save your work by clicking Save button which saves sketch 

byPACTICAL3_EXERCISE2 with .sec file extension. 

 

XII. Resources Used  

S. 

No. 
Name of Resource 

Broad Specifications 
Quantity 

Remarks 

(If any) Make Details 

1.       

2.       
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3.       

 

XIII. Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIV. Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XV. Course proficiency 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XVI.  Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

1. Describe the Palette feature used in this session. 

2. Write advantages and limitations of Palette feature used in this session. 

[Space for Answer] 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

XVI  Questions for Practice. 
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XVII References / Suggestions for Further Reading 

 https://www.youtube.com/watch?v=KQk-hn5DZVg 

 https://www.youtube.com/watch?v=lpH4ZUUD9N0 

 

XVIII Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) 40% 

1  Use of proper commands.   20% 

2 Completion of drawing with minimum size of 

model tree. 

20% 

Product Related (15 Marks) 60% 

3 Generation and printing of drawing views, tables, 

etc. and their arrangement on different sheet size. 

20% 

4 Able to answer oral questions. 20% 

5 Completion of work in time.  20% 

Total (25 Marks) 100 % 

 

 

Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………… 

4. ………………………… 

 

 

 

 

 

 

 

 

Marks Obtained Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.youtube.com/watch?v=KQk-hn5DZVg
https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=video&cd=5&ved=0ahUKEwikx5Xp2MzgAhXHdCsKHZtCDAMQtwIINzAE&url=https%3A%2F%2Fwww.youtube.com%2Fwatch%3Fv%3DlpH4ZUUD9N0&usg=AOvVaw0k0cjQof8YnbLTkBt8Xj__
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          Practical No.4: Draw and Print Two Simple 3-D Drawings using 3D  

                                   Modeling Commands. 

 
I Practical Significance 

To create solid models of any mechanical components. To learn different sketching 

and modeling commands. Also understand datum features and datum plane theory. 

Study different geometric and modeling constraints.  From design engineers point of 

view, can be seen the object from various directions and in various views. It helps to 

be sure that the object looks exactly as wanted. It also gives additional vision as to 

what more changes can be done in the object. 

 

II      Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and 

allied industry.  

 

III Competency and Skills 

This practical is expected to develop the following skills –  

 Geometric constraints – overview, apply equal length. 

 Dimension constraints, weak, strong, locked.  

 Viewing the model – default, flat sketch view, spin. 

 Datum plane - visibility.  

 Dashboard interface. 

 

IV Relevant Course Outcome(s) 

 Generate 3D models from 2D sketches using Part workbench of any parametric 

solid modeling software. 

 

V Practical Outcome 

 Operate available modeling software to draw 3D Models of any engineering 

product. 

 

VI Relative Affective Domain- 

 Working in team work. 

 Practice good housekeeping. 

 Demonstrate working as a leader/a team member. 

 Follow ethical practices. 
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VII Minimum Theoretical Background 

 Basic knowledge of reading of 3D objects.  

 Knowledge of creating working directory.  

Mouse Buttons 

 Left Button -Most commonly used for selecting objects on the screen or  

    sketching.  

 Right Button –Used for activating pop-up menu items, typically used when 

editing. (Note: you must hold the down button for 2 seconds)  

 Center Button – (option) Used for model rotation, dimensioning, zoom when 

holding Ctrl key, and pan when holding Shift key. It also cancels commands and 

line chains.  

 Center Scroll Wheel – (option) same as Center Button when depressed, only it 

activates Zoom feature when scrolling wheel. 

Solid modeling interface. 

 
In the Graphics toolbar at the top of the graphics area, disable or enable the display of 

any datum features whenever you want. 

 
Figure- Datum Features. 

Sketch Constraints & Relations: 
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Constraint 
Geometric entities to 

select 
Resulting Constraint 

Horizontal or 

Vertical 

One or more lines or two 

or more points. 

The lines become horizontal or 

vertical (as defined by the current 

sketch space). Points are aligned 

horizontally or vertically. 

Collinear Two or more lines. 
The items lie on the same infinite 

line. 

Perpendicular Two lines. 
The two items are perpendicular to 

each other. 

Parallel 

Two or more lines. 

A line and a plane (or a 

planar face) in a 3D sketch. 

The items are parallel to each other. 

The line is parallel to the selected 

plane. 

Tangent 
An arc, ellipse, or spline, 

and a line or arc. 
The two items remain tangent. 

Concentric 
Two or more arcs, or a 

point and an arc. 
The arcs share the same centerpoint. 

Midpoint 
Two lines or a point and a 

line. 

The point remains at the midpoint of 

the line. 

Coincident 
A point and a line, arc, or 

ellipse. 

The point lies on the line, arc, or 

ellipse. 

Equal 
Two or more lines or two 

or more arcs. 

The line lengths or radii remain 

equal. 

Symmetric 

A centerline and two 

points, lines, arcs, or 

ellipses. 

The items remain equidistant from 

the centerline, on a line 

perpendicular to the centerline. 

 

VIII Resources Required 
 

S. No. Name of Resource Suggested Broad Specification Quantity 

 

1. 

 

Hardware: Personal 

computer. 

 (i5 or higher), RAM minimum 4 GB; 

A3 / A4 size printer / plotter. Display-

wide Screen preferably. 

As  per 

batch 

size 

 

2. 

 

Operating system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 

As  per 

batch 

size 

 

3. 

 

Software 

Any parametric solid modeling 

software. 

As  per 

batch 

size 

4. Plotter Plotter A2 OR A3Size. 1 

 

IX Experimental setup: 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  
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X Precautions to be Followed 

1. Student should understand and can draw at least two Orthographic views of any 

model. 

2. While constructing 2D sketch, boundary (Area) of any profile should be enclosed. 

3. While specifying dimensions, carefully select the entity or end points of entity and 

click the middle button (roller) of mouse. 

4. Check given drawing for dimensional printing mistakes if any and if dimensions 

are missing assume proportionate dimensions.  

5. While constructing the drawing, periodically save your work.  

 

XI Procedure 

Exercise No.1-Createfollowinggiven 3D part using part modeling workbench of 

CAD software. 

 
         Following steps are required to create given solid 3D part in part modeling workbench. 

A. Start Solid modeling. 

B. Set the working directory. 

C. Start part model environment. 

D. Selecting the Sketching Plane for the Base Feature. 

E. Creating and Dimensioning the Sketch for the Base Feature. 

F. Selecting the Sketching Plane for the Second Feature. 

G. Creating and Dimensioning the Sketch for the Second Feature. 

H. Selecting the Sketching Plane for the Third Feature. 

I. Creating and Dimensioning the Sketch for the Third Feature. 

J. Selecting the Sketching Plane for the Forth Feature. 

K. Creating and Dimensioning the Sketch for the Forth Feature. 

L. Selecting the Sketching Plane for the Fifth Feature. 

M. Creating and Dimensioning the Sketch for the Fifth Feature. 

N. Save the part and close the file. 

O. Print drawing of part.  

 

A. Start Solid modeling parametric: As explained in practical No.01. 

B. Set Working Directory: As explained in practicalNo.01. 

C. Start part model environment- 
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1.Selecting File>New from the menu or click on the New File icon from 

the main toolbar. A new window will be displayed as shown in Figure by 

default. 

2.Select Part option from the same window  to sketch the 

drawing.Type name as PRACTICAL4_EXERCISE1.Click OK button. 

3.In the New dialog box, notice the default object Type is Part and Sub-type is 

Solid, these are the correct options for creating a solid part. Give the suitable 

Name for the model. Uncheck the Use default template and click OK. 

 
4. New File Box window will display on the screen. 

5. Then from New File options dialog box select solid partmmns_part_solid or 

solid_part_mmksand click OK. 
 

 
 

6 The part modeling workbench will display on the screen as shown in Figure. 

 
D. Selecting the Sketching Plane for the Base Feature: 

1 Now we have to create first base feature of the given part. So we need to draw a 

sketch of first feature on any one of the default plane. 
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2 Click on Sketch button from part modeling tool bar. Then Sketch window 

will appear as shown in Figure. 

 
3 Select the correct plane as per the part orientation by just clicking on the default 

plane. Click on Sketch button of the sketch window. 

 

4 Click on Orient View button to orient the view parallel to screen. 

E. Creating and Dimensioning the Sketch for the Base Feature: 

1 Select  from Sketching tool bar to draw rectangle. Giving first corner 

of rectangle as the origin and second point as shown in Figure. Click MMB to exit. 

 

 
2 To modify a dimension double-clickon its value using the LMB, and then type a 

new value 90 X 50 mm as per the drawing. Accept it by clicking on green 

colored Check mark. 

 

3 Select  button of part modeling tool bar. 
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4 Mention the height of 10 mm,Click on  to change depth direction 

of extrude. Click on  for preview, and finally click on accept button if 

extrude correct. 

 
5 Finally first feature of the part will look like as shown in Figure. 

 
F. Selecting the Sketching Plane for the Second Feature: 

1 Click on Sketch button from part modeling tool bar. Then Sketch window 

will appear as shown in Figure. 

2 Take the cursor on the top plane, and click on it. 

3 Click on Sketch of the sketch window. 

4 Click on Orient View button to orient the view parallel to screen. Then top 

plane of the first feature will ready for sketching of the second feature. 

 

 
 

G. Creating and Dimensioning the Sketch for the Second Feature. 

1 Select  from Sketching tool bar to draw rectangle. 
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2 Use  constraint tool to coincident three sides of the above rectangle. 

3 Select  and then select line and edge of the first features as shown in Figure. 

 

 
4 To modify a dimension double-click on its value using the LMB, and then type a 

new value 20 mm as per the drawing. Accept it by clicking on green colored 

Check mark. 

 

5 Select  button of part modeling tool bar. 

 



Solid Modelling and Additive Manufacturing (22053) 

 67 

 

6 Mention the height of 10 mm, Click on  to change depth direction 

of extrude. Click on  for preview, and finally click on Accept button 

if extrude correct. 

 
7 Finally first feature of the part will look like as shown in Figure. 

 
H. Selecting the Sketching Plane for the Third Feature: 

1 Click on sketch button from part modeling tool bar. Then Sketch window 

will appear. 

2 Take the cursor on the appropriate top plane according to given part, and click on 

it. 

3 Click on Sketch of the sketch window. 

4 Click on Orient View button to orient the view parallel to screen. Then top 

plane of the first feature will ready for sketching of the third feature as shown in 

Figure. 

 
I. Creating and Dimensioning the Sketch for the Third Feature. 

1 Select  from Sketching tool bar to draw rectangle. 
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2 Use  constraint tool to coincident two sides of the above rectangle. 

3 Select  and then select line and edge first features as shown in Figure. 

 
4 To modify a dimension double-clickon its value using the LMB, and then type a 

new value 40 X 20 mm as per the drawing. Accept it by clicking on green 

colored Check mark. 

 

5 Select  button of part modeling tool bar. 
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6 Mentionthe height of 20 mm , Click on  to change depth 

direction of extrude. Click on  for preview, and finally click on 

Accept button if extrude correct. 

 
7 Finally first feature of the part will look like as shown in Figure. 

 
J. Selecting the Sketching Plane for the Forth Feature: 

1 Click on Sketch button from part modeling tool bar. Then Sketch 

window will appear. 

2 Take the cursor on the appropriate plane according to given part, and click on 

it. 

3 Click on Sketch of the sketch window. 

4 Click on Orient View button to orient the view parallel to screen. Then 

plane of the second feature will ready for sketching of the forth feature as 

shown in Figure. 
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K. Creating and Dimensioning the Sketch for the Forth Feature: 

1 Select  from Sketching tool bar to draw rectangle. 

 

2 Use Constraint tool to coincident two sides of the above rectangle. 

3 Select  and then select line and edge second features as shown in Figure. 

4 To modify a dimension double-clickon its value using the LMB, and then type a 

new value 20 X 20 mm as per the drawing. Accept it by clicking on green check 

mark.  

 

 

5 Select  button of part modeling tool bar. 
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6 Mention the height of 20 mm, Click on  remove material. Click 

on  to change depth direction of extrude. Click on  for preview, 

and finally click on accept button if extrude correct. 

 
7 Finally forth feature of the part will look like as shown in Figure. 

 
L. Selecting the Sketching Plane for the Fifth Feature: 

1 Click on Sketch button from part modeling tool bar. Then Sketch window 

will appear. 

2 Take the cursor on the first feature top plane according to given part, and click on it. 

3 Click on Sketch of the sketch window. 

4 Click on Orient View button to orient the view parallel to screen. Then plane 

of the first feature will ready for sketching of the fifth feature as shown in Figure. 
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M. Creating and Dimensioning the Sketch for the Fifth Feature: 

1 Select  from sketching tool bar to draw rectangle. 

 

2 Use Constraint tool to coincident two sides of the above rectangle. 

3 Select  and then select line and edge second features as shown in Figure. 

4 To modify a dimension double-clickon its value using the LMB, and then type 

a new value 20 X 30 mm as per the drawing. Accept it by clicking on green 

 

5 Select  button of part modeling tool bar. 
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6 Mention the height of 10 mm, Click on  remove material. 

Click on  to change depth direction of extrude.Click on  for 

preview, and finally click on accept button if extrude correct. 

 
7 Finally fifth feature of the part will look like as shown in Figure. 

 
 

N. Save the part and close the file. 

O. Print drawing of the part. 

1 Open part model to be print. 

2 Start new drawing file. Click File> Drawing .Uncheck on Use default 

template. Click OKas shown in Figure. 
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3 New definition dialog box will display, choose Empty with formatoption. Browse 

format of the template prepared as practical4_templatefrom the working directory. 
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4 Select Layout option from drawing tool bar. Choose General .Select Default 

views and OK. 
6 Move the cursor in A4 size sheet, and double click. Choose the views according to 

First Angle Method and locate it correct position. 

7 Click on Annotate option from drawing tool bar and give the dimensions as shown 

in Figure.  

8 Finally the front ,top and side view as per the First angle Method will seen as shown 

in Figure with dimension.  

 
 

9 Click Save button to save the drawing in working directory. 

Exercise No.1- Create followinggiven 3D part using part modeling workbench     

    of CAD software. 
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Following steps are required to create given solid 3D part in part modeling workbench. 

A. Start Solid modeling. 

B. Set the working directory. 

C. Start part model environment. 

D. Selecting the Sketching Plane for the Base Feature. 

E. Creating and Dimensioning the Sketch for the Base Feature. 

F. Selecting the Sketching Plane for the Second Feature. 

G. Creating and Dimensioning the Sketch for the Second Feature. 

H. Selecting the Sketching Plane for the Third Feature. 

I. Creating and Dimensioning the Sketch for the Third Feature. 

J. Save the part and close the file. 

K. Printing of part drawing. 

 

A. Start Solid modeling parametric: As explained in practical No.01. 

B. Set Working Directory:As explained in practical No.01. 

C. Start part model environment: As explained in practical No.04 Exercise1. 

1 Type name as PRACTICAL4_EXERCISE2.Click OK button as shown in figure.  

 

 
2 New File Box window will display on the screen. 

3 Then from New File options dialog box select ‘solid_part_mmks’ and click OK. 

4 Part modeling workbench will display on the screen. 

D. Selecting the Sketching Plane for the Base Feature: 

5 Now we have to create first base feature of the given part. So we need to draw a 

sketch of first feature on any one of the default plane. 
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6 Click on Sketch button from part modeling tool bar. Then Sketch 

window will appear as shown in Figure. 

 
7 Select the correct plane as per the part orientation by just clicking on the 

default plane. Click on Sketch button 

 

8 Click on Orient View button to orient the view parallel to screen. 

E. Creating and Dimensioning the Sketch for the Base Feature. 

1 Activate the grid from the View option tool bar as shown in Figure. 

 
2 Click File>Options>Sketcher. Set the grid spacing by 5 mm as shown in 

Figure. Click OK button. 

 

6 Select  from sketching tool bar to draw line close loop profile as 

shown in figure. 
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7. Click MMB to exit. Weak dimensions will appear on the drawing. 

 
 

F. To modify a dimension double-clickon its value using the LMB, and then type a new 

value as per the drawing. Accept it by clicking on green colored Check mark. 

 

 

7 Select  button of part modeling tool bar. 
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8 Mention the height of 100 mm, Click on  to change depth 

direction of extrude. Click on  for preview, and finally click on 

accept button if extrude correct. 

 
 

9 Finally base feature of the part will look like as shown in Figure. 

 
 

G. Selecting the Sketching Plane for the second Feature: 
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5 Click on Sketch button from part modeling tool bar. Then Sketch window 

will appear. 

6 Take the cursor on the appropriate plane according to given part, and click on 

it. 

7 Click on Sketch of the sketch window. 

8 Click on Orient View button to orient the view parallel to screen. Then 

plane of the second feature will ready for sketching of the second feature as 

shown in Figure. 

 
H. Creating and Dimensioning the Sketch for the second Feature. 

2 Select  from Sketching tool bar to draw rectangle. 

 

6 Use  constraint tool to coincident two sides of the above rectangle. 

7 Select  and then select line and edge of the first features as shown in 

Figure. 

8 To modify a dimension double-clickon its value using the LMB, and then 

type a new value 20 X 50 mm as per the drawing. Accept it by clicking on 

green check mark. 
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9 Select  button of part modeling tool bar. 

 

8 Mention the height of 40 mm, Click on  remove material. Click 

on  to change depth direction of extrude. Click on  for preview, 

and finally click on accept button if extrude correct. You will get second 

feature of the part as shown in Figure. 
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I. Selecting the Sketching Plane for the Third Feature. 

10 Click on Sketch button from part modeling tool bar. Then Sketch 

window will appear. 

11 Take the cursor on the first feature top plane according to given part, and click 

on it. 

12 Click on Sketch of the sketch window. 

 

1 Click on Orient View button to orient the view parallel to screen. Then 

plane of the first feature will ready for sketching of the third feature as shown 

in Figure. 
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J. Creating and Dimensioning the Sketch for the Third Feature. 

1 Select  from Sketching tool bar to draw rectangle. 

 
 

2 Use  constraint tool to coincident two sides of the above rectangle. 

3 Select  and then select line and edge first features as shown in Figure. 

4 To modify a dimension double-click on its value using the LMB, and then type a 

new value 40 X 25 mm as per the drawing. Accept it by clicking on green 
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2 Select  button of part modeling tool bar. 

 

8 Mention the height of 25 mm, Click on  remove material. Click 

on  to change depth direction of extrude.Click on  for preview, and 

finally click on accept button if extrude correct. 

 

9 Finally third feature of the part will look like as shown in Figure. 

 

 
5. Save the part and close the file. 

K. Print drawing of the part: 

1 Open part model to be print. 

2 Start new drawing file. Click File> Drawing .Uncheck on Use default 

template.  
3 Type the name practical4_exercise2.Click OK as shown in Figure. 
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4 New definition dialog box will display, choose Empty with formatoption. 

Browse format of the template prepared as practical4_ex2_templatefrom the 

working directory. 

 

 
 

 
5 A4 size template will available for part drawing as shown in Figure. 
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5 Select Layout option from drawing tool bar. Choose General .Select Default 

viewsandclick OK. 

 
1 Move the cursor in A4 size sheet, and double click. Choose the views 

according to First Angle Method and locate it correct position. 

2 Choose FRONT from Model view names window. Select Apply> Close 

 

 
1. SelectView Displayoption. Choose Hidden option. 
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2. Select  button from drawing tool bar. 

3. Repeat the same procedure for next view according to First Angle of Projection 

as shown in Figure. 

4. Click on Annotate option from drawing tool bar. Choose

dimensions button and give the dimensions as shown in Figure.  

 
 

5. Finally the front ,top and side view as per the First angle Method will seen 

as shown in Figure with dimension.  

6. Click Save button to save the drawing in working directory. 

 

XII Resources Used  

S. 

No. 

Name of 

Resource 

Broad Specifications Quantity Remarks 

(If any) Make Details 

1.       

2.       

3.       

 

XIII Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIV Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  
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 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XV Course proficiency 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XVI   Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

 

Questions: 

1. Explain application of solid modeling in industry. 

2. List different types of tool bar used in part modeling.  

 

[Space for Answer] 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 

XVII References / Suggestions for Further Reading 

 https://www.youtube.com/watch?v=ZUPRT95V4Ek 

 https://www.youtube.com/watch?v=OPmjH5QfiRs 

 https://www.youtube.com/watch?v=O78bWdxjqWs 

 

XVIII Assessment Scheme 

Performance Indicators Weightage 

Process Related (10 Marks) 40% 

1  Use of proper commands.   20% 

2 Completion of drawing with minimum size of 

model tree. 

20% 

Product Related (15 Marks) 60% 

3 Generation and printing of drawing views, tables, 

etc. and their arrangement on different sheet size. 

20% 

4 Able to answer oral questions. 20% 

5 Completion of work in time.  20% 

Total (25 Marks) 100 % 

 

 

Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………… 

 

 

 

 

 

 

  

Marks Obtained Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.youtube.com/watch?v=ZUPRT95V4Ek
https://www.youtube.com/watch?v=OPmjH5QfiRs
https://www.youtube.com/watch?v=O78bWdxjqWs
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Practical No.5: Develop Solid Models Of Individual Components Of 

Bench Vice / Drill Jig / Screw Jack / Tool Post 

Assembly Consisting Of At Least Five Parts.  

 

I Practical Significance 

To create solid models of any mechanical components. To learn different sketching 

and modeling commands. Also understand datum features and datum plane theory. 

Study different geometric and modeling constraints.  From design engineers point of 

view, can be seen the object from various directions and in various views. It helps to 

be sure that the object looks exactly as wanted. It also gives additional vision as to 

what more changes can be done in the object. 

 

II       Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and 

allied industry.  

 

III Competency and Skills 

This practical is expected to develop the following skills –  

 Starting and creating new parts.  

 Controlling the display of datum features datum plane theory. 

 Datum plane - visibility.  

 Dashboard interface. 

 Revolve Protrusion. 

 

IV Relevant Course Outcome(s) 

 Generate 3D models from 2D sketches using Part workbench of any parametric 

Modeling software. 

V Practical Outcome 

 Operate available modeling software to draw 3D Models of any engineering 

product. 

 

VI Relative Affective Domain- 

 Working in team work. 

 Practice good housekeeping. 

 Demonstrate working as a leader/a team member. 

 Follow ethical Practices. 



Solid Modelling and Additive Manufacturing (22053) 

 91 

VII Minimum Theoretical Background 

 Basic knowledge of reading of 3D objects.  

 Knowledge of creating working directory.  

 Basic knowledge of preparation of 2D sketches.  

 

VIII Resources Required 
 

S. 

No. 

Name of Resource Suggested Broad Specification Quantity 

 

1. 

 

Hardware: Personal 

computer. 

 (i5 or higher), RAM minimum 4 GB; 

A3 / A4 size printer / plotter. Display-

wide Screen preferably. 

As  per 

batch size 

 

2. 

 

Operating system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 

As  per 

batch size 

 

3. 

 

Software 

Any parametric solid modeling 

software. 

As  per 

batch size 

4. Plotter Plotter A2 OR A3Size. 1 

 

IX Precautions to be Followed 

1. Student should understand and can visualize at least two Orthographic views of 

any model. 

2. Check given drawing for dimensional printing mistakes if any and if dimensions 

are missing assume proportionate dimensions.  

3. While using Sweep or Helical sweep command, need to draw reference axis, 

reference line, trajectory and helical sweep section. These activity should do 

carefully. 

4. While constructing the drawing, periodically save your work.  

 

X Procedure 

For Setting the Working Directory and Selection of Sketching Plane (Step 1 & Step 2): 

Follow the steps as explained in Previous Practical’s.   

Step 3: Create a sketch to define the shape of Body of the Screw Jack.  

1. Draw a Centerline by picking from ‘Datum’ group. Place the 

centerline by picking two co-linear points as shown in Figure. 

 
Construction of centerline 
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2. Create a profile shown in the Figure with the help of Line chain 

command from sketching group.  

 
Line Dashboard. 

 

 
View of Screw Jack Body.   Profile of Screw Jack Body without Fillet. 

  

 

 

3. Create and Edit the dimensions by using  

Normal from Dimension group.  

 

 

     Dashboard of Normal Dimensions. 

 

4. Click OK from the Close group of the Sketch tab to 

complete the sketch and return to the Revolve / Extrude dashboard.  
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 Then click on Revolve command from Shapes group then select axis / 

centerline.  

 

 
   Dashboard of Revolve command 

 

Revolved Feature - creates features that add or remove material by revolving one or more 

profiles around a centerline. The feature can be a solid, a thin feature, or a surface. 

      

 
Axis of revolution for body profile. 

 

 
Angle of rotation and Accept Dashboard. 

 

5. Enter an angle value as 360 and click Accept button.  

 

We will get body of the screw jack without fillets as shown in the Figure. 
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Body of Screw Jack without fillets. 

 

6. Then provide the fillets with the help of Round command from 

engineering group at required corners / edges and specify respective radius and click 

on Accept button. Do this activity separately for every edge.   

   

  
Radius and Accept dashboard.

 
                  (a)      (b) 

 
     (c) 

Fig. (a), (b), (c) – Fillets at different edges and corners  
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We will get final shape of Screw Jack Body with Fillets as shown in the Figure. 

 

 
Body of Screw Jack with fillets. 

 

7. Saving your work  

 In the Quick Access toolbar, click Save to save your model.  

 In the Save Object dialog, click OK to specify that the model will be saved to 

your working directory.  

 

XI Resources Used  

S. 

No. 

Name of 

Resource 

Broad Specifications 
Quantity 

Remarks 

(If any) Make Details 

1.       

2.       

3.       

 

XII Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIII Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  
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XIV Course Proficiency  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XV  Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

 

XVI    Questions: 

1. State the meaning of mmns, mmks. 

2. List different uses of mouse buttons. 

 

[Space for Answer] 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

XVII References / Suggestions for Further Reading 

1. https://www.youtube.com/watch?v=XlsaSe444AE 

2. https://www.youtube.com/watch?v=b6b9FY14PKw 

3. https://www.youtube.com/watch?v=X0AMdUMNsDI 

 

XVIII  Assessment Scheme 

Performance Indicators Weightage 

Process Related (10 Marks) 40% 

1  Use of proper commands.   20% 

2 Completion of drawing with minimum size of 

model tree. 

20% 

Product Related (15 Marks) 60% 

3 Generation and printing of drawing views, tables, 

etc. and their arrangement on different sheet size. 

20% 

4 Able to answer oral questions. 20% 

5 Completion of work in time.  20% 

Total (25 Marks) 100 % 

 

Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………… 

 

 

 

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.youtube.com/watch?v=XlsaSe444AE
https://www.youtube.com/watch?v=b6b9FY14PKw
https://www.youtube.com/watch?v=X0AMdUMNsDI
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Practical No.6: Develop solid models of individual components of Bench 

Vice / Drill Jig / Screw Jack / Tool Post / anyone 

assembly consisting of at least five parts 
 

I Practical Significance 

To create solid models of any mechanical components.To learn different sketching and 

modeling commands. Also understand datum features and datum plane theory. Study 

different geometric and modeling constraints.  From design engineers point of view, 

can be seen the object from various directions and in various views. It helps to be sure 

that the object looks exactly as wanted. It also gives additional vision as to what more 

changes can be done in the object. 

 

II       Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and 

allied industry.  

 

III Competency and Skills 

This practical is expected to develop the following skills  

 Starting and creating new parts.  

 Datum plane - visibility.  

 Dashboard interface. 

 Revolve Protrusion.  

 

IV Relevant Course Outcome(s) 

 Generate 3D models from 2D sketches using Part workbench of any parametric 

Modeling software. 

 

V Practical Outcome 

 Operate available modeling software to draw 3D Models of any engineering 

product. 

 

VI Relative Affective Domain- 

 Demonstrate working as a leader/a team member. 

 Follow ethical Practices. 
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VII Minimum Theoretical Background 

 Basic knowledge of reading of 3D objects.  

 Knowledge of creating working directory.  

 Basic knowledge of preparation of 2D sketches.  

 Basic knowledge of computer handling. 

 Basic knowledge of geometric and dimensional constructions. 

 

VIII Resources Required 
 

S. 

No. 
Name of Resource Suggested Broad Specification Quantity 

 

1. 

 

Hardware: Personal 

computer. 

 (i5 or higher), RAM minimum 4 GB; 

A3 / A4 size printer / plotter. Display-

wide Screen preferably. 

As  per 

batch size 

 

2. 

 

Operating system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 

As  per 

batch size 

 

3. 

 

Software 

Any parametric solid modeling 

software. 

As  per 

batch size 

4. Plotter Plotter A2 OR A3Size. 1 

 

XVI Precautions to be Followed 

1. Student should understand and can visualize at least two Orthographic views of 

any model. 

2. While constructing 2D sketch, boundary (Area) of any profile should be enclosed. 

3. While specifying dimensions, carefully select the entity or end points of entity and 

click the middle button (roller) of mouse. 

4. Check given drawing for dimensional printing mistakes if any and if dimensions 

are missing assume proportionate dimensions.  

5. While using Sweep or Helical sweep command, need to draw reference axis, 

reference line, trajectory and helical sweep section. These activity should do 

carefully. 

6. While constructing the drawing, periodically save your work.  

 

IX Procedure 

For Setting the Working Directory and Selection of Sketching Plane (Step 1 & Step 2): 

Follow the steps as explained in First Practical.  

Step 3: Create a sketch to define the shape of Nut of the Screw Jack.  

1. Draw a Centerline by picking from ‘Datum’ group. Place the 

centerline by picking two co-linear points as shown in Figure. 
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Construction of centerline 

2. Create a profile shown in the Figure with the help of Line chain 

command from sketching group.  

 

 
    Line Dashboard. 

 

 
View of Screw Jack Nut.    Profile of Screw Jack Nut without Fillet.

    

3. Create and Edit the dimensions by using Normal from Dimension group.  
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Dashboard of Normal Dimensions. 

 

4. Click OK from the Close group of the Sketch tab to complete the sketch and 

return to the Revolve / Extrude dashboard.  

 
Dashboard of Accept. 

 

5. Then click on Revolve command from Shapes group then select axis / 

centerline.  

 
Dashboard of Revolve command 

 

Revolved Feature - creates features that add or remove material by revolving one or more 

profiles around a centerline. The feature can be a solid, a thin feature, or a surface. 

 

 
Axis of revolution for Nut profile. 
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6. Enter an angle value as 360 and click Accept button. 

 

 
Angle of rotation and Accept Dashboard. 

 

We will get body of the screw jack without fillets as shown in the Figure. 

 

 
Nut of Screw Jack without fillets. 

7. Then provide the fillets with the help of Round command from 

Engineering group at required corners / edges and specify respective radius and click 

on Accept button. Do this activity separately for every edge.  

 
Radius dashboard. 

 
Round command dashboard. 

 

 

(a)               (b) 
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     (c) 

(a), (b), and (c) – Fillets at different corners and edges. 

 

We will get final shape of Screw Jack Nut with Fillets as shown in the Figure. 

 
Nut of Screw Jack with fillets. 

 

8. Saving your work  

• In the Quick Access toolbar, click Save to save your model.  

• In the Save Object dialog, click OK to specify that the model will be saved to your 

working directory.  

 

X Resources Used  

S. 

No. 

Name of 

Resource 

Broad Specifications Quantity Remarks 

(If any) Make Details 

1.       

2.       

3.       

 

XI Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XII Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  
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XIII Course Proficiency 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIV  Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

Questions: 

1. State any two elements required for Revolve Protrusion.  

2. Explain different methods of selection of sketching planes. 

3. List five uses of datum planes. 

 

[Space for Answer] 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 

XV References / Suggestions for Further Reading 

1. https://www.youtube.com/watch?v=XlsaSe444AE 

2. https://www.youtube.com/watch?v=b6b9FY14PKw 

3. https://www.youtube.com/watch?v=X0AMdUMNsDI 

 

XVI  Assessment Scheme 

Performance Indicators Weightage 

Process Related (10 Marks) 40% 

1  Use of proper commands.   20% 

2 Completion of drawing with minimum size of 

model tree. 

20% 

Product Related (15 Marks) 60% 

3 Generation and printing of drawing views, tables, 

etc. and their arrangement on different sheet size. 

20% 

4 Able to answer oral questions. 20% 

5 Completion of work in time.  20% 

Total (25 Marks) 100 % 

 

 

Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………… 

 

 

 

 

 

 

 

 

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.youtube.com/watch?v=XlsaSe444AE
https://www.youtube.com/watch?v=b6b9FY14PKw
https://www.youtube.com/watch?v=X0AMdUMNsDI
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Practical No.7: Develop Solid Models Of Individual Components Of Bench 

Vice / Drill Jig / Screw Jack/ Tool Post / Anyone Assembly 

Consisting Of At Least Five Parts.  
 

I Practical Significance 

To create solid models of any mechanical components.To learn different sketching and 

modeling commands. Also understand datum features and datum plane theory. Study 

different geometric and modeling constraints.  From design engineers point of view, 

can be seen the object from various directions and in various views. It helps to be sure 

that the object looks exactly as wanted. It also gives additional vision as to what more 

changes can be done in the object. 

 

II      Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and 

allied industry.  

 

III Competency and Skills 

This practical is expected to develop the following skills –  

 Starting and creating new parts.  

 Dashboard interface. 

 Revolve Protrusion.  

 Sweep and Helical Sweep. 

 Concept of Trajectory. 

 

IV Relevant Course Outcome(s) 

 Generate 3D models from 2D sketches using Part workbench of any parametric 

Modeling software. 

 

V Practical Outcome 

 Operate available modeling software to draw 3D Models of any engineering 

product. 

 

VI Relative Affective Domain- 

 Demonstrate working as a leader/a team member. 

 Follow ethical Practices. 
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VII Minimum Theoretical Background 

 Basic knowledge of reading of 3D objects.  

 Knowledge of creating working directory.  

 Basic knowledge of preparation of 2D sketches.  

 Basic knowledge of computer handling. 

 Basic knowledge of geometric and dimensional constructions. 

 

VIII Resources Required 
 

S. 

No. 
Name of Resource Suggested Broad Specification Quantity 

 

1. 

 

Hardware: Personal 

computer. 

 (i5 or higher), RAM minimum 4 GB; A3 

/ A4 size printer / plotter. Display-wide 

Screen preferably. 

As  per 

batch size 

 

2. 

 

Operating system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 

As  per 

batch size 

 

3. 

 

Software 

Any parametric solid modeling software. As  per 

batch size 

4. Plotter Plotter A2 OR A3Size. 1 

 

IX Precautions to be Followed 

1. Student should understand and can visualize at least two Orthographic views of 

any model. 

2. While constructing 2D sketch, boundary (Area) of any profile should be enclosed. 

3. While specifying dimensions, carefully select the entity or end points of entity and 

click the middle button (roller) of mouse. 

4. Check given drawing for dimensional printing mistakes if any and if dimensions 

are missing assume proportionate dimensions.  

5. While using Sweep or Helical sweep command, need to draw reference axis, 

reference line, trajectory and helical sweep section. These activities should do 

carefully. 

6. While constructing the drawing, periodically save your work.  

 

X Procedure 
 

For Setting the Working Directory and Selection of Sketching Plane (Step 1 & Step 2): 

Follow the steps as explained in First Practical.   

Step 3: Create a sketch to define the shape of Screw Spindle of the Screw Jack.  

 

1. Draw a Centerline by picking from ‘Datum’ group. Place the centerline 

by picking two co-linear points as shown in alongside Figure. 
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Construction of centerline. 

 

2. Create a profile shown in the Figure with the help of Line chain 

command from sketching group.  

 
Line Dashboard. 

 

 
View of Screw Spindle. 
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Profile of Screw Spindle. 

 

3. Create and Edit the dimensions by using Normal from Dimension group. 

 

 
Dashboard of Normal Dimension. 

 

4. Click OK from the Close group of the Sketch tab to complete the sketch and 

return to the Revolve / Extrude dashboard.  

 

 
     Dashboard of Accept. 

 

5. Then click on Revolve command from Shapes group then select axis / 

centerline.  

 
Dashboard of Revolve command. 
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            Revolved Feature - creates features that add or remove material by revolving one or  

            more profiles around a centerline. The feature can be a solid, a thin feature, or a  

            surface.     

  
Axis of revolution for Screw Spindle. 

 

6. Take revolution angle as 360. And click on Accept button. 

 

 

 
Angle of rotation and Accept Dashboard. 

 

                   We will get Screw Spindle of the screw jack without threads as shown in the  

                    Figure. 

 

 
Screw Spindle without Hole & Threads. 

7. Create a throughout hole on central reference plane (Shank portion) of Screw Spindle 

at specified distance.  
 

i) Go to Sketch menu. 

ii) Set a line reference by clicking Setup group > References and select the edge 

as shown in the Figure[Line (Reference)] 
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References Dashboard. 

 

iii) Draw circle on the axis as shown and edit dimensions, diameter as 12mm and 

distance as 35mm from reference line.  

 
Circular Sketch for circular Hole.  

 

iv) Click Accept / OK from the Close group of the Sketch tab to complete 

the sketch and return to the Revolve / Extrude dashboard.  

v) Click on ‘Extrude from sketch plane by a specified depth value’ feature. 
  

 
(a)–Extrude Dashboard. 

 

 OR click on ‘Extrude on both sides of sketch plane by half the specified depth 

value in each direction’ feature.  
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(b)– Extrude Dashboard. 

 

vi) Drag the reference handles and set the dimension of the hole and its depth, in 

the extrude dashboard. 

vii) Then click on ‘Remove Material’ feature as shown below.  
 

 
Remove material Dashboard. 

viii) Then click Accept  to finish the feature creation. 

 

 
Accept Dashboard. 

 

We will get the throughout hole as shown in Figure below. 

 

 
(a)-Completed Hole feature. 
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ix) By selecting another reference plane, follow the same procedure to create 

another throughout hole on Shank Portion of Screw Spindle as shown in the 

Figure. 

 
(b)– Completed Hole feature from both side. 

 

8. Create Threads on Screw Spindle. 

i) Go to Sketch menu. 

ii) Set a reference by clicking Setup group > 

References and select left side edge as a reference 

shown in the Figure. 

 
Reference Dashboard. Reference line, Trajectory & Center line 

 

iii) Draw Trajectory by using line command on earlier created reference i.e. on left 

side of spindle surface. 

iv) Then draw geometrical centerline at the axis of spindle by using centerline 

command from datum group as shown in the Figure. 

v) Then click Accept  button.  
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     Note:-Start point or end point of the Trajectory should be somewhat away from 

the bottom surface of the object as shown in the Figure. 

vi) By taking Helical Sweep Command, then select create or edit sweep section 

command and draw section of screw thread (i.e. Sweep Section) at the End 

Point of the Trajectory / Line, by using Center Rectangle command 

considering pitch of screw thread as 7mm.  

 

 

 

 

 

 

 

 

 

     

    Helical Sweep Dashboard 

 

 
 Pitch of Screw Dashboard. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Construction of Center Rectangle  

 

 
Rectangular Thread Section at the end of Trajectory.  

 

 

 



Solid Modelling and Additive Manufacturing (22053) 

 115 

vii) Click on Remove Material button. 

 

 
 Threaded Screw 

 

viii) Then click on Accept  button. 

 

We will get threads on Spindle as shown in the Figure. 

 
 

 
Completed threaded Screw Spindle. 

 

           Finally we will get final shape of Screw Spindle with all features as shown in the  

           Figure. 
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9. Saving your work  

• In the Quick Access toolbar, click Save to save your model.  

 

• In the Save Object dialog, click OK to specify that the model will be saved to your 

working directory.  

 

XI Resources Used  

 

S. 

No. 

Name of 

Resource 

Broad Specifications 
Quantity 

Remarks 

(If any) Make Details 

1.       

2.       

3.       

 

XII Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIII Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIV Course Proficiency 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XV  Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

Questions: 

1. List three uses of datum axes. 

2. Explain Normal dimension feature. 

3. Explain the model tree. 
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4. Use of Reference line during threading process. 

 

[Space for Answer] 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 

XVI References / Suggestions for Further Reading 

1. https://www.youtube.com/watch?v=XlsaSe444AE 

2. https://www.youtube.com/watch?v=b6b9FY14PKw 

3. https://www.youtube.com/watch?v=X0AMdUMNsDI 

 

XVII  Assessment Scheme 

Performance Indicators Weightage 

Process Related (10 Marks) 40% 

1  Use of proper commands.   20% 

2 Completion of drawing with minimum size of 

model tree. 
20% 

Product Related (15 Marks) 60% 

3 Generation and printing of drawing views, tables, 

etc. and their arrangement on different sheet size. 
20% 

4 Able to answer oral questions. 20% 

5 Completion of work in time.  20% 

Total (25 Marks) 100 % 

 

Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………… 

 

 

 

 

 

 

 

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.youtube.com/watch?v=XlsaSe444AE
https://www.youtube.com/watch?v=b6b9FY14PKw
https://www.youtube.com/watch?v=X0AMdUMNsDI
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Practical No.8 : Develop Solid Models of Individual Components of Bench 

Vice / Drill Jig / Screw Jack / Tool Post Assembly 

Consisting Of At Least Five Parts.  

 
I Practical Significance 

To create solid models of any mechanical components. To learn different sketching 

and modeling commands. Also understand datum features and datum plane theory. 

Study different geometric and modeling constraints. From design engineers point of 

view, can be seen the object from various directions and in various views. It helps to 

be sure that the object looks exactly as wanted. It also gives additional vision as to 

what more changes can be done in the object. 

 

II    Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and 

allied industry.  

 

III Competency and Skills 

This practical is expected to develop the following skills –  

 Starting and creating new parts.  

 Controlling the display of datum features datum plane theory. 

 Sweep and Helical Sweep. 

 Concept of Trajectory. 

 

IV Relevant Course Outcome(s) 

 Generate 3D models from 2D sketches using Part workbench of any parametric 

Modeling software. 

 

V Practical Outcome 

 Operate available modeling software to draw 3D Models of any engineering 

product. 

 

VI Relative Affective Domain- 

 Demonstrate working as a leader/a team member. 

 Follow ethical Practices. 
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VII Minimum Theoretical Background 

 Basic knowledge of reading of 3D objects.  

 Knowledge of creating working directory.  

 Basic knowledge of preparation of 2D sketches.  

 Basic knowledge of computer handling. 

 Basic knowledge of geometric and dimensional constructions. 

 

VIII Resources Required 
 

S. 

No. 
Name of Resource Suggested Broad Specification Quantity 

 

1. 

 

Hardware: Personal 

computer. 

 (i5 or higher), RAM minimum 4 GB; 

A3 / A4 size printer / plotter. Display-

wide Screen preferably. 

As  per 

batch 

size 

 

2. 

 

Operating system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 

As  per 

batch 

size 

 

3. 

 

Software 

Any parametric solid modeling 

software. 

As  per 

batch 

size 

4. Plotter Plotter A2 OR A3Size. 1 

 

IX Precautions to be Followed 

1. Student should understand and can visualize at least two Orthographic views of 

any model. 

2. While constructing 2D sketch, boundary (Area) of any profile should be enclosed. 

3. While specifying dimensions, carefully select the entity or end points of entity and 

click the middle button (roller) of mouse. 

4. Check given drawing for dimensional printing mistakes if any and if dimensions 

are missing assume proportionate dimensions.  

5. While using Sweep or Helical sweep command, need to draw reference axis, 

reference line, trajectory and helical sweep section. These activity should do 

carefully. 

6. While constructing the drawing, periodically save your work.  

 

X Procedure 
 

For Setting the Working Directory and Selection of Sketching Plane (Step 1 & Step 2): 

Follow the steps as explained in Previous Practical’s.   

 

Step 3: Create a sketch to define the shape of Cup of the Screw Jack.  

1. Draw a Centerline  by pickingfrom ‘Datum’ group. Place the centerline by 

picking two co-linear points as shown in Figure. 
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Construction of centerline 

 

2. Create a profile shown in the Figure with the help of Line chain 

command from sketching group.  

 
Line Dashboard 

 

 
       Viewof Cup.                              Profileof Cup. 
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4. Create and Edit the dimensions by using Normal from Dimension group.  

 

 
Dashboard of Normal Dimension. 

 

5. Click OK from the Close group of the Sketch tab to complete the sketch 

and return to the Revolve / Extrude dashboard.  

 

 
     Dashboard of Accept. 

 

 

6. Then click on Revolve command from Shapes group then select axis / 

centerline.  

 

      Revolved Feature - creates features that add or remove material by revolving one or  

      more profiles around a centerline. The feature can be a solid, a thin feature, or a  

      surface. 

 

 
Dashboard of Revolve command. 
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Axis of revolution for Screw Jack Cup. 

 

7. Take revolution angle as 360 and click on Accept button. 

 

 
Angle of rotation and Accept Dashboard. 

 

                      We will get Screw Jack Cup as shown in the Figure. 

 

 
Modelof Screw Jack Cup without Slots. 

8. Create a Semicircular Slots.  
 

i) Go to Sketch menu. 

ii) Set a line reference by clicking Setup group > References and select the edge 

as shown in the Figure [Line (Reference)] 
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References Dashboard. 

 

iii) Draw circle of diameter 10mm at the intersecting point of reference lines. 

 

 
Circular Sketch for Semicircular Slot.  

iv) Click OK from the Close group of the Sketch tab to complete the sketch 

and return to the Extrude dashboard.  

 

v) Click on ‘Extrude from sketch plane by a specified depth value’ feature. 
  

 
(a)– Extrude Dashboard. 

 

 OR click on ‘Extrude on both sides of sketch plane by half the specified depth 

value in each direction’ feature.  
 

 
(b)– Extrude Dashboard. 
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vi) Drag the reference handles and set the diameter of the hole and its depth, in the 

dashboard. 

vii) Then click on ‘Remove Material’ feature.  

 
 

Remove material Dashboard. 

viii) Then click Accept to finish the feature creation. 
 

 
Accept Dashboard. 

 

 
 

Completed Slot feature. 

 

ix) By selecting another reference plane, follow the above procedure to 

createotherSemicircular Slot as shown in the Figure. 

 

 
 

 

 

 

 

 

 

 

 

 

 
 

 

Completed Screw Jack Cup with Semicircular Slots. 
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9. Saving your work  

• In the Quick Access toolbar, click Save to save your model.  

 

• In the Save Object dialog, click OK to specify that the model will be saved to your 

working directory.  

 

Step 4: Create a sketch to define the shape of Washer of the Screw Jack.  

1. Draw a Centerline  by picking from ‘Datum’ group. Place the centerline 

by picking two co-linear points as shown in Figure. 

 

 

 
Construction of centerline 

2. Create a profile shown in the Figure with the help of Line chain 

command from sketching group.  

 
Line Dashboard. 
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View of Screw Jack Washer. 

 

 
Profile of Screw Jack Washer without Fillet. 

 

3. Create and Edit the dimensions by using Normal from Dimension group.  

 

 
Dashboard of Normal Dimension. 

 

4. Click OK from the Close group of the Sketch tab to complete the sketch 

and return to the Revolve / Extrude dashboard.  
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    Dashboard of Accept. 

 

5. Then click on Revolve command from Shapes group then select axis / 

centerline.  

 

Revolved Feature - creates features that add or remove material by revolving one or 

more profiles around a centerline. The feature can be a solid, a thin feature, or a 

surface. 

 
    Dashboard of Revolve command. 

 

 
Axis of revolution for Screw Jack Washer. 

 

                         We will get Screw Jack Washer as shown in the Figure. 
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Model of Screw Jack Washer without Fillets. 

 

6. Then provide the fillet with the help of Round command from 

Engineering group at the corner / edge and specify respective radius.  

 

Specify the proportionate value of radius, as it is not given in the sketch.  

 

 
Round Dashboard. 

 

 
Radius Dashboard. 
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Washer of Screw Jack with fillet. 

 

7. Click OK to complete the Fillet. 
 

We will get final shape of Screw Jack Nut with Fillets as shown in the Figure. 

 
Washer of Screw Jack with fillet. 

 

8. Saving your work  

 In the Quick Access toolbar, click Save to save your model.  

 

 In the Save Object dialog, click OK to specify that the model will be saved to your 

working directory.  

 

Step 5: Create a sketch to define the shape of Screw of the Screw Jack.  

 

1. Draw a Centerline by picking from ‘Datum’ group. Place the centerline 

by picking two co-linear points as shown in Figure. 
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Construction of centerline 

 

2. Create a profile shown in the Figure with the help of Line chain 

command from sketching group.  

 
Line Dashboard. 

 

 
View of Screw of Screw Jack. 
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Profile of Screw. 

 

3. Create and Edit the dimensions by using Normal from Dimension group.  

 

 
Dashboard Normal Dimension. 

 

4. Click OK from the Close group of the Sketch tab to complete the sketch and 

return to the Revolve / Extrude dashboard.  

 

 
Dashboard for Accept / OK Tool 

 

5. Then click on Revolve command from Shapes group then select axis / 

centerline.  
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        Revolved Feature - creates features that add or remove material by revolving one or  

        more profiles around a centerline. The feature can be a solid, a thin feature, or a surface. 

 
Dashboard for Revolve command. 

 

 
Axis of revolution for Screw Profile. 

 

           We will get Screw as shown in the Figure. 

 
Model of Screw without Slot & Chamfer. 
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6. To create rectangular slot at the top surface of the screw. 

(i) Select the surface as a sketching plane shown in the Figure and then click on 

the Sketching toolbar.  

 

 
Selected surface for creating slot. 

 

(ii) Click on the Center Rectangle icon as shown in Figure to activate the 

Rectangle command. 

 
Dashboard for Rectangle command.  

 

(iii) Create a rectangle by clicking Point (1) as center point of rectangle and point 

(2) as upper right corner of rectangle as shown below. 

(iv) Create and Edit the dimensions by using Normal from Dimension 

group. Edit width as 2 mm. 

 

 
 Creation of Rectangular feature. 
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Dashboard of Normal Dimension. 

 

 
Dimension Edition  

 

(v) Then click on Accept buttonfrom the Close group of the Sketch tab to 

complete the sketch and return to the Extrude dashboard.  

 

(vi) Click on ‘Extrude command then specify depth value as 3mm. 
  

 
Dashboard for dimension edition. 

 

(vii) Then click on ‘Remove Material’ feature.  
 

 
Dashboard for Material Removal. 

 

(viii) To complete the feature clickOK/ Accept button shown below. 
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Rectangular Slot Feature 

 

 
Dashboard for Accept button. 

 

 We will get the screw with rectangular slot as shown below.  

 
 

Screw with Rectangular slot. 

 

 
 

7. To create Chamfer at bottom circular edge. 
 

(i) Click on the Chamfer command from engineering group as shown below.  
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Dashboard for Chamfer command.  

 

(ii) Select the edge as shown in the Figure and provide the chamfer value as 1mm. 

 
Dashboard for Dimension edition. 

 

 
Selection of edge for chamfering. 

 

(iii) To complete the feature click OK / Accept button shown below. 

 

 
Dashboard for Accept button. 
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We will get completed Solid Screw with Slot and Chamfer as shown in the Figure. 

 
Screw with Rectangular Slot and Chamfer 

 

 

8. Create Threads on Screw 

 

i) Go to Sketch menu. 

ii) Set a reference by clicking Setup group > References and select left side edge 

as a reference.  

 
Reference Dashboard. 

 

iii) Draw Trajectory by using line command on earlier created reference i.e. on one 

side of screw surface.  

iv) Then draw geometrical centerline at the axis of screw by using centerline 

command from datum group.  

v) Then click Accept button.  
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vi) By taking Helical Sweep Command, draw section of screw thread (i.e. Sweep 

Section – V shape) at the End Point of the Trajectory / Line, by using line 

command considering pitch of screw thread as 1.25mm.   

 

 
Helical Sweep Dashboard 

 

 
Pitch of Screw Dashboard. 

 

 
V shape Thread section.  

 

vii) After creating a sweep section (V shape) click on Accept button. 
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Completed Screw with All features. 

 

9. Saving your work  

 In the Quick Access toolbar, click Save to save your model.  

 

 In the Save Object dialog, click OK to specify that the model will be saved to your 

working directory.  

 

 

      Step 6: Create a sketch to define the shape of Tommy Bar of the Screw Jack.  

 

1. Draw a Centerline  by picking from ‘Datum’ group. Place the centerline 

by picking two co-linear points as shown in Figure. 

 

 
Construction of centerline 
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2. Create a profile shown in the Figure with the help of Line chain  

command from sketching group.  

 

 
Line Dashboard. 

 

 

 

 
View of Tommy Bar of Screw Jack. 

 

 
Profile of Tommy Bar of Screw Jack without rounds at the end. 

3. Create and Edit the dimensions by using Normal  from Dimension group.  

 
Dashboard of Normal Dimension. 
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4. Click OK from the Close group of the Sketch tab to complete the sketch and 

return to the Revolve / Extrude dashboard.  

 

 
Dashboard of Accept. 

 

5. Then click on Revolve command from Shapes group then select axis / 

centerline.  

 

Revolved Feature - creates features that add or remove material by revolving one or 

more profiles around a centerline. The feature can be a solid, a thin feature, or a surface. 

 
Dashboard of Revolve command. 

 

 
Axis of revolution for Tommy Bar. 

 

6. Take revolution angle as 360. And click on Accept  button. 
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Angle of rotation and Accept Dashboard. 

 

                   We will get Tommy Bar as shown in the Figure. 

 

 
Model of Tommy Bar without Rounds. 

7. Then provide the fillets / rounds with the help of Round command 

from Engineering group at required corners / edges and specify respective radius.  

 
    Round command dashboard. 

8. Specify the radius of round as 10mm. after specifying the value of radius click on 

Accept button.  
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Radius dashboard. 

9. Specify the radius of round at other end as 6mm. After specifying the value of radius 

click on Accept button.  

 

 
(b) 

 
Radius dashboard. 

     We will get final shape of Tommy Bar with Rounds as shown in the Figure. 

 

 
Tommy Bar of Screw Jack with Rounds. 

10. Saving your work  

 In the Quick Access toolbar, click Save to save your model.  

 

 In the Save Object dialog, click OK to specify that the model will be saved to your 

working directory.  

 

XVI. Resources Used  
 

S. 

No. 

Name of 

Resource 

Broad Specifications 
Quantity 

Remarks 

(If any) Make Details 

1.       

2.       

3.       

 

XVII. Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  
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XVIII. Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIX.  Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

1. Explain the procedure to construct a Center Rectangle. 

2. Explain the Chamfering procedure. 

 

[Space for Answer] 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

XX. References / Suggestions for Further Reading 

1. https://www.youtube.com/watch?v=XlsaSe444AE 

2. https://www.youtube.com/watch?v=b6b9FY14PKw 

3. https://www.youtube.com/watch?v=X0AMdUMNsDI 

 

XXI. Assessment Scheme 

Performance Indicators Weightage 

Process Related (10 Marks) 40% 

1  Use of proper commands.   20% 

2 Completion of drawing with minimum size of 

model tree. 
20% 

Product Related (15 Marks) 60% 

3 Generation and printing of drawing views, tables, 

etc. and their arrangement on different sheet size. 
20% 

4 Able to answer oral questions. 20% 

5 Completion of work in time.  20% 

Total (25 Marks) 100 % 

 

Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………… 

 

 

 

 

 

 

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.youtube.com/watch?v=XlsaSe444AE
https://www.youtube.com/watch?v=b6b9FY14PKw
https://www.youtube.com/watch?v=X0AMdUMNsDI
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          Practical No.9: Assemble and Print the orthographic views of the  

                            assembly developed in PrO 5 to 8 with bill of materials.  

 
I. Practical Significance 

To create a 3D feature assemblies of relative components. Just as you can combine 

features into parts, you can also combine parts into assemblies. Any Modeling 

Parametric CAD Software enables you to place component parts and subassemblies 

together to form assemblies. It also helps you modify, analyze, or reorient the resulting 

assemblies. Such a virtual designed models and assemblies can be used to easily 

visualize and evaluate your design before costly prototypes are manufactured. 

II     Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and 

allied industry.  

 

III Competency and Skills 

This practical is expected to develop the following skills for the industry identified 

competency –  

 Create new Modeling Parametric assembly. 

 Assemble the components of an assembly using the Default constraint. 

 Assembly constraints – Automatic, fully constrained.  

 

IV Relevant Course Outcome(s) 

 Prepare assemblies of part models using assembly workbench of any parametric 

CAD software. 

 

V Practical Outcome 

 Use any available parametric CAD modeling software to draw and assemble the 

different parts at their respective working position for engineering products. 

 

VI Relative Affective Domain- 

 Demonstrate working as a leader/a team member. 

 Follow ethical Practices. 

 

VII Minimum Theoretical Background 

 Methods for Assembly. 

 3-D Dragger.  

 Position and relationship in between the parts to be assembled. 
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 Bill of materials. 

 Basic knowledge of geometric constructions. 

 Constrain Components. 

 

Methods of Assembly 

There are two main approaches of assembly in CAD modeling software –  

1. Bottom-up Assembly. 

2. Top-down Assembly. 

The bottom-up approach is the traditional approach. In bottom-up assembly, 

designing / modeling of parts done separately and then call them in assembly 

environment and apply constraints for them. 

In top-down assembly,designing / modeling and assembly of the parts are done in 

assembly environment itself and no need to constrain top down assembly parts.  

3-D Dragger : - 

The color coded 3-D dragger is used to orient the component being assembled within 

the assembly. As constraints are added and the degrees of freedom are reduced, you will 

notice that those corresponding portions of the dragger are grayed out. 

 The shaded arcs of the dragger control rotation about the three axes. 

 The shaded arrows translate the component along those axes. 

 These small translucent (shining) quadrants move the component in a 2-D plane. 

 The small sphere at the center is used to pan the component in any direction. 

 

 

3D-Dragger. 

Operation Keyboard and Mouse Selection 

Spin – The component will spin within 

the assembly. Partially constrained 

components only spin in unconstrained 

directions.  

Pan – The component will pan about the 

assembly. Partially constrained 

components only spin in unconstrained 

directions.  

Component Drag – The component will 

spin and pan about the assembly. 

Partially constrained components can be 

dragged only in unconstrained 

directions. 
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Constrain Components 

 

After you have placed and oriented a component it is important that you add assembly 

constraints to define its final design position. 

 

 A Coincident constraint is applied to cylindrical surface of each part. This 

constraint type makes the center axis of each model coincident. 

 

 A second Coincident constraint is applied to datum planes FRONT of each 

model. Making the two planes coincident. 

 Constraints such as Coincident , Parallel , Distance and so on 

can be explicitly selected from the constraint drop-down menu in the dashboard under 

Automatic, however, it is often easier to let Solid Modeling Parametric select them 

based on the references you select. In this case, selecting the two cylindrical surfaces 

caused a Coincident constraint to be automatically applied. If the planes were 

farther apart when selected, a Distance constraint may have been applied. 

 

VIII Resources Required 
 

S. 

No. 
Name of Resource Suggested Broad Specification Quantity 

 

1. 

 

Hardware: Personal 

computer. 

(i5 or higher), RAM minimum 4 GB; 

A3 / A4 size printer / plotter. Display-

wide Screen preferably. 

As  per 

batch 

size 

 

2. 

 

Operating system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 

As  per 

batch 

size 

 

3. 

 

Software 

Any parametric solid modeling 

software. 

As  per 

batch 

size 

4. Plotter Plotter A2 OR A3Size. 1 

 

IX Precautions to be Followed 

1. Units used while designing the individual models and units used while assembly 

should same. (eg. mm or inch). 

2. While assembling first part (base part), assemble the first component at default 

constraint location. 

3. Each and every part, which are get assembled at respective working position 

should fully constrained.  
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X Procedure 

Step 1: Set working directory and create a new assembly  
 

1. Start Solid Modeling Parametric.  

2. Set the working directory as explained in earlier practical’s. 

3. Creating the new assembly model:  

 From the Quick Access toolbar or Home tab, click New.  

 In the New dialog box, click to select Type as Assemblyand Sub-type as 

Design as the new model type.  

 Type Assembly_of_Screw_Jack in the Name field, uncheck the ‘Use default 

template’ and click OK. 

 
New dialog box. 

 

 A ‘New File Options’ dialog box will pop up, from this dialog box select 

‘mmns_asm_design’ OR ‘mmks_asm_design’ option and click OK. 

 

 
New File Options dialog box. 
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Assembly Environment. 
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Step 2: Adding the first component to the assembly  

 

1. Selecting the component to assemble: 

 

 Click ‘Assemble’  tool from Component group of Model tab. 

 In the lower-right corner of the Open dialog box, click to expand the Preview 

pane.  

 Browse the location where you have saved Screw Jack Body model and select 

it.  

 Click Open to assemble this component.  

 
Calling of First object i.e. Screw Jack Body. 

 

 The part will be attached to the cursor and the Assembly dashboard will open.  

 
Assembly dashboard. 

 

Locating the part temporarily, before final placement: 

Drag the Screw Jack Body just to the left of the assembly coordinate system, and then click in 

the graphics area to place it. Later, when placing components, you will use the 3D Dragger to 

position the component close to its final destination.  
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Location of part before final placement. 

2. Adding assembly constraints: 

 In the Assembly dashboard, click Automatic and select 

Default from the drop-down menu.  

 
Default location. 

 

The Screw Jack model is now constrained to the default center of the graphics area, 

where the assembly coordinate system is located.  
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Screw Jack body constrained to default center. 

 

 Components change to a yellow-orangecolor after they have been fully constrained.  

 

          The Assembly dashboard shows the Default constraint type message confirms the part  

           is Fully Constrained. 

 

 
Default and Fully Constrained dashboard. 

 

3. Complete the placement of the part:  

 In the Assembly dashboard, click Complete Component to complete 

the component placement.  

 
Placement of Base component (body). 
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4. Click Save to save your work.  

 

 
5. Change the display of datum features:  

 In the Graphics toolbar, disable the display of 

Point display and Plane display.  

 Default coordinate system and axis display 

should be displayed at the center.  

 

 

 

 

      Datum features with Base component. 

 

Step 3: Add the Second component (Nut) to the assembly  

 

1. Selecting the Second part to assemble:  

 

 Click ‘Assemble’  tool from Component group of Model tab. 

 In the lower-right corner of the Open dialog box, click to expand the Preview 

pane.  

 Browse the location where you have saved Nut model and select it.  

 Click Open to assemble this component.  

 
Calling of Second object i.e. Nut. 

 The part will be attached to the cursor and the Assembly dashboard will open.  
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Nut with base component (body). 

 

 
Automatic and No Constraints dashboard. 

 

2. Locating the part temporarily, before final placement:  

 Drag the Nut to a position just to the right of the Body, and then click in the 

graphics area to place it.  

 

3. Adding the first assembly constraint:  

 Move the cursor over the axis of Nut till it shows the cursor tip as shown atX1.  

 

 
First Assembly Constraint i.e. Axis of Nut. 

 

 When the cursor shows cursor tip shown at X1, click to select the axis. Then it 

displays Automatic. 

 
Selection of First Assembly Constraint i.e. Axis of Nut. 

 Move the cursor over the axis of the body till it shows the cursor tip as shown at 

X2. Then click to select the axis of body.  
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Second Assembly Constraint i.e. Axis of Body. 

 Then select the Coincident constraint from the Component Placement > 

Constraint dashboard. 

 

 
Application of Coincident Constraint. 

 If required drag and click on Flip Axis Constraint from the Placement tab in 

order to flip the orientation of a constraint.  

 

 
Before Flip Axis Constraint. 

 

 
After Flip Axis Constraint. 



Solid Modelling and Additive Manufacturing (22053) 

 158 

 

 Then drag the Nut towards upper side of the body.  

  

4. Adding the second assembly constraint:  

 Press the middle-mouse button and drag to spin the model until you can see the flat 

surface of body shown as X1.  

 Click to select the flat surface of the Body(X1) that it closest to and facing the 

surface of Nut X2.  

 

 
Second Assembly Constraint i.e. Surface of Body (X1). 

 Press the middle-mouse button and drag to spin the model until you can see the flat 

surface shown as X2 of the Nut.  
 

 
Selection of Second Assembly Constraint i.e. Surface of Nut (X2). 

 

 Click to select the flat surface of Nut shown as X2.  

 Then from Constrained dashboard select coincident constraint. 

 
Selection of Coincident Constraint. 
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 Solid Modeling Parametric recognizes two flat surfaces facing each other and 

applies a Coincident constraint. These two selected surface are now coincident to 

each other.  

 
Coincident both the parts. 

 The Nut has changed to a yellow-orange color indicating that its position is fully 

constrained.  

 The Assembly dashboard shows the Coincident constraint type was the last used 

and that the Nut is now Fully Constrained.  

 
Coincident Assembly constraint with Fully Constrained dashboard. 

 

 Click Complete Component to complete the component placement.  

 Then the Nut returns to its original gray color.  

 

5. Reorienting and saving your work:  

 Press CTRL + D to reorient the model.  

 Click Save to save your work. 

 

 
Reoriented body and nut assembly. 

Step 3: Adding the Next component to the assembly (i.e. Screw Spindle) 

1. Selecting the Next part to assemble:  
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 Click ‘Assemble’  tool from Component group of Model tab. 

 In the lower-right corner of the Open dialog box, click to expand the Preview 

pane.  

 Browse the location where you have savedScrew Spindle model and select it.  

 Click Open to assemble this component.  

 

 
Calling of Next object i.e. Screw Spindle. 

 The part will be attached to the cursor and the Assembly dashboard will open.  

 

 
Screw Spindle with body and nut. 

 

 
Automatic and No Constraints dashboard. 

2. Locating the part temporarily, before final placement:  

 Drag the Screw Spindle to a position just to the right of the Assembly, and 

then click in the graphics area to place it.  
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Screw Spindle towards right side of assembly. 

3. Adding the first assembly constraint:  

 Move the cursor over the axis of Screw Spindle till it shows the cursor tip as 

shown at X1.  

 
First Assembly Constraint i.e. Axis of Screw Spindle. 

 When the cursor shows cursor tip shown at X1, click to select the axis. Then it 

displays Automatic. 

 

 
Selection of First Assembly Constraint i.e. Screw Spindle. 

 Move the cursor over the axis of the body till it shows the cursor tip as shown at 

X2. Then click to select the axis of body.  
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Second Assembly Constraint i.e. Axis of Body. 

 

 Then select the Coincident constraint from the Component Placement > 

Constraint dashboard. 

 

 
Before Application of Coincident Constraint. 

 

 
After Application of Coincident Constraint. 

 

 If required click on Flip Axis Constraint from the Placement tab in order to flip 

the orientation of a constraint.  

 Then drag the Screw Spindle towards upper side of the Assembly.  
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Dragging of Screw Spindle along the constrained axes. 

4. Adding the second assembly constraint:  

 If required press the middle-mouse button and drag to spin the model until you can 

see the flat surface shown as X1 on the Nut.  

 Click to select the flat surface of the Nut(X1) that it closest to and facing the 

surface of Screw Spindle(X2).  

 

 
Second Assembly Constraint i.e. Surface of Nut (X1). 

 

 Press the middle-mouse button and drag to spin and zoom the model until you can 

see the flat surface shown as X2 of the Screw Spindle.  

 

 
Selection of Second Assembly Constraint i.e. Surface of Screw Spindle (X2). 
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 Click to select the flat surface of Screw Spindle shown as X2.  

 If required, then from Constrained dashboard select coincident constraint. 

 
Coincident both the parts. 

 Solid Modeling Parametric recognizes two flat surfaces facing each other and 

applies a Coincident constraint. These two selected surface are now coincident to 

each other.  

 The Screw Spindle has changed to a yellow-orange color indicating that its 

position is fully constrained.  

 The Assembly dashboard shows the Coincident constraint type was the last used 

and that the Screw Spindle is now Fully Constrained.  

 
Coincident Assembly constraint with Fully Constrained dashboard. 

 Click Complete Component to complete the component placement.  

 Then the Screw Spindle returns to its original gray color.  

5. Reorienting and saving your work:  

 Press CTRL + D to reorient the model.  

 Click Save  to save your work. 

 

 
Reoriented Assembly. 
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XI Resources Used  
 

S. 

No. 

Name of 

Resource 

Broad Specifications Quantity Remarks 

(If any) Make Details 

1.       

2.       

3.       

 

 

XII Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIII Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIV Course Proficiency 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XV  Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

1. Create models of individual components and Assemble any one of the following 

assembly – Bench vice ,Drill Jig. 

2. List different assembly constraints. 

 

[Space for Answer] 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

XVI References / Suggestions for Further Reading 

1. https://www.youtube.com/watch?v=xzteh5MFDs4 
2. https://www.youtube.com/watch?v=Yp2SbrxhfNQ 
3. https://www.youtube.com/watch?v=nbhQTShOS0o 
4. https://www.youtube.com/watch?v=mFNZHaQYw60 

 

XVII  Assessment Scheme 

Performance Indicators Weightage 

Process Related (10 Marks) 40% 

1  Use of proper commands.   20% 

2 Completion of drawing with minimum size of 

model tree. 

20% 

Product Related (15 Marks) 60% 

3 Generation and printing of drawing views, tables, 

etc. and their arrangement on different sheet size. 

20% 

4 Able to answer oral questions. 20% 

5 Completion of work in time.  20% 

Total (25 Marks) 100 % 

 

Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………… 

 

 

 

 

 

 

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.youtube.com/watch?v=xzteh5MFDs4
https://www.youtube.com/watch?v=Yp2SbrxhfNQ
https://www.youtube.com/watch?v=nbhQTShOS0o
https://www.youtube.com/watch?v=mFNZHaQYw60
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Practical No.10: Assemble and Print the orthographic views of the assembly 

developed in PrO 5 to 8 with bill of materials.  
 

------------------- Continued From Previous Practical –  

 

Step 4: Adding the Next component to the assembly (i.e. Tommy bar) 

 

1. Selecting the Next part to assemble:  

 

 Click ‘Assemble’  tool from Component group of Model tab. 

 In the lower-right corner of the Open dialog box, click to expand the Preview 

pane.  

 Browse the location where you have savedTommy bar model and select it.  

 Click Open to assemble this component.  

 
Calling of Next object i.e. Tommy bar. 

 The part will be attached to the cursor and the Assembly dashboard will open.  

 
Tommy bar with Assembly. 

 

 
Automatic and No Constraints dashboard. 

 

2. Locating the part temporarily, before final placement:  
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 Drag the Tommy bar to a position just to the right of the Assembly, and then 

click in the graphics area to place it.  

 

 
Tommy bar towards right side of assembly. 

3. Adding the first assembly constraint:  

 Move the cursor over the axis of Tommy bar till it shows the cursor tip as shown at 

X1.  

 

 
First Assembly Constraint (X1) i.e. Axis of Tommy bar. 

 When the cursor shows cursor tip shown at X1, click to select the axis. Then it 

displays Automatic. 

 

 
Selection of First Assembly Constraint (X1) i.e. Axis of Tommy bar. 

 

 Move the cursor over the axis of the Screw Spindle till it shows the cursor tip as 

shown at X2. Then click to select the axis of Screw Spindle.  
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Second Assembly Constraint (X2) i.e. Axis of Screw Spindle. 

 

 Then if required, select the Coincident constraint from the Component 

Placement > Constraint dashboard. 

 If required click on Flip Axis Constraint from the Placement tab in order to flip 

the orientation of a constraint.  

 Then if required, drag the Tommy bar towards the hole of screw spindle.  

 

4. Adding the second assembly constraint:  

 

 If required press the middle-mouse button and drag to spin the model until you can 

see the flat surface shown as X1 on the Tommy bar.  

 Click to select the flat surface of the Tommy bar(X1) that it closest to and facing 

the surface of Screw Spindlehole (X2).  

 

 
Second Assembly Constraint i.e. Surface of Tommy bar (X1). 

 Press the middle-mouse button and drag to spin and zoom the model until you can 

see the flat surface shown as X2 of the Screw Spindle hole.  

 

 
Selection of Second Assembly Constraint i.e. Surface of Screw Spindle hole (X2). 

 

 Click to select the flat surface of Screw Spindle hole shown as X2.  

 If required, then from Constrained dashboard select coincident constraint. 
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 Solid Modeling Parametric recognizes two cylindrical surfaces facing each other 

and applies a Coincident constraint. These two selected surface are now coincident 

to each other.  

 Click Complete Component to complete the component placement.  

 Then the Tommy bar returns to its original gray color.  

 

5. Reorienting and saving your work:  

 Press CTRL + D to reorient the model.  

 Click Save  to save your work. 

 

 
Reoriented Assembly. 

Step 5: Adding the Next component to the assembly (i.e. Cup) 

 

1. Selecting the Next part to assemble:  

 Click ‘Assemble’  tool from Component group of Model tab. 

 In the lower-right corner of the Open dialog box, click to expand the Preview 

pane.  

 Browse the location where you have savedCup model and select it.  

 Click Open to assemble this component.  

 

 
Calling of Next object i.e. Cup. 

 

 The part will be attached to the cursor and the Assembly dashboard will open.  
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Cup with Assembly. 

 
Automatic and No Constraints dashboard. 

2. Locating the part temporarily, before final placement:  

 Drag the Cup to a position just to the top of the Assembly, and then click in 

the graphics area to place it.  

 
Cup towards Top side of assembly. 

3. Adding the first assembly constraint:  

 Move the cursor over the axis of Cup till it shows the cursor tip as shown at X1.  

 
First Assembly Constraint (X1) i.e. Axis of Cup. 
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 Then the cursor shows cursor tip shown at X1, click to select the axis. Then it 

displays Automatic. 

 

 
Selection of First Assembly Constraint (X1) i.e. Axis of Cup. 

 

 Move the cursor over the axis of the Screw Spindle till it shows the cursor tip as 

shown at X2. Then click to select the axis of the Screw Spindle.  

 

 
Second Assembly Constraint (X2) i.e. Axis of Screw Spindle. 

 

 Then select the Coincident constraint from the Component Placement > 

Constraint dashboard. 

 
Before Application of Coincident Constraint. 
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After Application of Coincident Constraint. 

 If required click on Flip Axis Constraint from the Placement tab in order to flip 

the orientation of a constraint.  

 Then drag the Cup towards upper side of the Assembly.  

 
Dragging of Cup along the constrained axes. 

 

4. Adding the second assembly constraint:  

 If required press the middle-mouse button and drag to spin the model until you can 

see the flat surface shown as X1 on the Screw Spindle.  

 Click to select the flat surface of the Screw Spindle (X1) that it closest to and 

facing the surface of Cup(X2).  

 

 
Second Assembly Constraint i.e. Surface of Screw Spindle (X1). 
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 Press the middle-mouse button and drag to spin and zoom the model until you can 

see the flat surface shown as X2 of the Cup.  

 

 
Selection of Second Assembly Constraint i.e. Surface of Cup (X2). 

 

 Click to select the flat surface of Cup shown as X2.  

 If required, then from Constrained dashboard select coincident constraint. 

 
Coincident both the parts. 

 

 Solid Modeling Parametric recognizes two flat surfaces facing each other and 

applies a Coincident constraint. These two selected surface are now coincident to 

each other.  

 The Cup has changed to a yellow-orange color indicating that its position is fully 

constrained.  

 The Assembly dashboard shows the Coincident constraint type was the last used 

and that the Cup is now Fully Constrained.  

 

 
Coincident Assembly constraint with Fully Constrained dashboard. 
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 Click Complete Component to complete the component placement.  

 Then the Cup returns to its original gray color.  

 

5. Reorienting and saving your work:  

 Press CTRL + D to reorient the model.  

 Click Save  to save your work. 

 

 
Reoriented Assembly. 

Step 6: Adding the Next component to the assembly (i.e. Washer) 

1. Selecting the Next part to assemble:  

 Click ‘Assemble’  tool from Component group of Model tab. 

 In the lower-right corner of the Open dialog box, click to expand the Preview 

pane.  

 Browse the location where you have saved Washer model and select it.  

 Click Open to assemble this component.  

 

 
Calling of Next object i.e. Washer. 

 The part will be attached to the cursor and the Assembly dashboard will open.  
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Washer with Assembly. 

 

 
Automatic and No Constraints dashboard. 

2. Locating the part temporarily, before final placement:  

 Drag and zoom the Washer to a position just to the top of the Assembly, and 

then click in the graphics area to place it.  

 
Washer towards Top side of assembly. 

3. Adding the first assembly constraint:  

 Zoom and move the cursor over the axis of Washer till it shows the cursor tip  

     as shown at X1.  

 
First Assembly Constraint (X1) i.e. Axis of Washer. 
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 When the cursor shows cursor tip shown at X1, click to select the axis.  

         Then it displays Automatic. 

 
Selection of First Assembly Constraint (X1) i.e. Axis of Washer. 

 

 Move the cursor over the axis of the Cup till it shows the cursor tip as  

         shown at X2. Then click to select the axis of the Cup.  

 

 
Second Assembly Constraint (X2) i.e. Axis of Cup. 

 

 Then select the Coincident constraint from the Component Placement > 

Constraint dashboard. 

 

 
Before Application of Coincident Constraint. 
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After Application of Coincident Constraint. 

 If required click on Flip Axis Constraint from the Placement tab in order to  

      flip the orientation of a constraint.  

 Then drag the washer towards upper side of the Assembly.  

 

4. Adding the second assembly constraint:  

 If required press the middle-mouse button and drag to spin the model until you  

      can see the flat surface shown as X1 on the Cup base.  

 Click to select the flat surface of the Cup base (X1) that it closest to and facing  

       the surface of Washer(X2).  

 
Second Assembly Constraint i.e. Surface of Washer (X1). 

 

 Press the middle-mouse button and drag to spin and zoom the model until you  

      can see the flat surface shown as X2 of the Washer.  
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Selection of Second Assembly Constraint i.e. Surface of Washer (X2). 

 

 Click to select the flat surface of Washer shown as X2.  

 Then from Constrained dashboard select coincident constraint. 

 

 
Coincident constraints of both the parts. 

 
Coincident both the parts. 

 Solid Modeling Parametric recognizes two flat surfaces facing each other and  

   applies a Coincident constraint. These two selected surface are now coincident  

   to each other.  
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 The Washer has changed to a yellow-orange color indicating that its position 

is fully constrained.  

 The Assembly dashboard shows the Coincident constraint type was the last 

used and that the Washer is now Fully Constrained.  

 

 
Coincident Assembly constraint with Fully Constrained dashboard. 

 

 Click Complete Component to complete the component placement.  

 Then the Washer returns to its original gray color.  

 

5. Reorienting and saving your work:  

 Press CTRL + D to reorient the model.  

 Click Save  to save your work. 

 

 
Reoriented Assembly. 

Step 7: Adding the Next component to the assembly (i.e. Screw) 

 

1. Selecting the Next part to assemble:  

 Click ‘Assemble’  tool from Component group of Model tab. 

 In the lower-right corner of the Open dialog box, click to expand the Preview 

pane.  

 Browse the location where you have savedScrew model and select it.  

 Click Open to assemble this component.  
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Calling of Next object i.e. Screw. 

 The part will be attached to the cursor and the Assembly dashboard will open.  

 

 
Screw with Assembly. 

 
Automatic and No Constraints dashboard. 

2. Locating the part temporarily, before final placement:  

 Drag and zoom the Screw to a position just to the top of the Assembly, and 

then click in the graphics area to place it.  

 
Screw towards Top side of assembly. 
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3. Adding the first assembly constraint:  

 Zoom and move the cursor over the axis of Screw till it shows the cursor tip as 

shown at X1.  

 
First Assembly Constraint (X1) i.e. Axis of Screw. 

 

 When the cursor shows cursor tip shown at X1, click to select the axis. Then it 

displays Automatic. 

 
Selection of First Assembly Constraint (X1) i.e. Axis of Screw. 

 Move the cursor over the axis of the Cup / Washer till it shows the cursor tip as 

shown at X2. Then click to select the axis of the Cup / Washer.  

 
Second Assembly Constraint (X2) i.e. Axis of Cup. 

 

 Then select the Coincident constraint from the Component Placement > 

Constraint dashboard. 
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Before Application of Coincident Constraint. 

 

 
After Application of Coincident Constraint. 

 If required click on Flip Axis Constraint from the Placement tab in order to flip 

the orientation of a constraint.  

 Then drag the Screw towards upper side of the Assembly.  

 

4. Adding the second assembly constraint:  

 If required press the middle-mouse button and drag to spin and zoom the model 

until you can see the head surface of screw shown as X1.  

 Click to select the head surface of the screw (X1) that it closest to and parallel to 

the surface of Washer(X2).  
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Second Assembly Constraint i.e. Surface of Screw (X1). 

 

 Press the middle-mouse button and drag to spin and zoom the model until you can 

see the flat surface shown as X2 of the Washer.  

 

 
 

Selection of Second Assembly Constraint i.e. flatSurface of Washer (X2). 

 

 Click to select the flat surface of Washer shown as X2.  

 Then from Constrained dashboard select coincident constraint. 
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(a) – Coincident both the parts. 

 

 

 
(b) – Coincident both the parts. 

 

 Solid Modeling Parametric recognizes two flat surfaces facing parallel to each 

other and applies a Coincident constraint. These two selected surface are now 

coincident to each other.  

 The Washer has changed to a yellow-orange color indicating that its position is 

fully constrained.  

 The Assembly dashboard shows the Coincident constraint type was the last used 

and that the Screw is now Fully Constrained.  

 

 
Coincident Assembly constraint with Fully Constrained dashboard. 

 Click Complete Component to complete the component placement.  

 Then the Screw returns to its original gray color.  

 

5. Reorienting and saving your work:  

 Press CTRL + D to reorient the model.  

 Click Save  to save your work. 
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Reoriented Assembly. 

 

XVIII Resources Used  

 

S. 

No. 

Name of 

Resource 

Broad Specifications 
Quantity 

Remarks 

(If any) Make Details 

1      

2      

3      

 

XIX Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XX Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XXI Course Proficiency 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  
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XXII Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

 

1. Explain – fully constrained object. 

2. Explain different constraint used in assembly with relative sketches. 

 

[Space for Answer] 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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XXIII  Questions for Practice. 

1. Create models of individual components of Tool Post and Assemble it. 

 

XXIV References / Suggestions for Further Reading 

1. https://www.youtube.com/watch?v=xzteh5MFDs4 

2. https://www.youtube.com/watch?v=Yp2SbrxhfNQ 

 

XXV Assessment Scheme 

Performance Indicators Weightage 

Process Related (10 Marks) 40% 

1  Use of proper commands.   20% 

2 Completion of drawing with minimum size of 

model tree. 
20% 

Product Related (15 Marks) 60% 

3 Generation and printing of drawing views, tables, 

etc. and their arrangement on different sheet size. 
20% 

4 Able to answer oral questions. 20% 

5 Completion of work in time.  20% 

Total (25 Marks) 100 % 

 

Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………… 

 

 

 

 

 

 

 

 

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.youtube.com/watch?v=xzteh5MFDs4
https://www.youtube.com/watch?v=Yp2SbrxhfNQ
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          Practical No.11: Assemble and Print the Orthographic Views of the 

Assembly Developed in Pro 5 to 8 With Bill of Materials. 

 
I Practical Significance 

Drawing views provide a means communication between the design engineers and 

production personnel. By studying this practical one can automatically create 

traditional 2D orthographic and detail views of either a 3D model or an assembly and 

one can easily prepare a Bill of Materials. 

 

II        Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and 

allied industry.  

 

III Competency and Skills 

This practical is expected to develop the following skills for the industry identified 

competency –  

 Opening an existing assembly / component.  

 Starting a new drawing - paper size, template.  

 Apply dimensions to the drawing views. 

 Preparation of Bill of Material. 

 

IV Relevant Course Outcome(s) 

 Generate orthographic views of 3D solid assemblies using Drawing workbench of 

any parametric CAD software. 

 Generate production drawing for given part models / assemblies.  

 

V Practical Outcome 

 Use any available parametric CAD modeling software to create and print 

orthographic views of assembly for any engineering products. 

 

VI Relative Affective Domain- 

 Demonstrate working as a leader/a team member. 

 Follow ethical Practices. 

 

VII Minimum Theoretical Background 

 Knowledge of drawing workbench of CAD modeling software. 

 Types and Method of dimensions. 

 Basic knowledge of reference projection views. 
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VIII Resources Required 
 

S. 

No. 
Name of Resource Suggested Broad Specification Quantity 

 

1. 

 

Hardware: Personal 

computer. 

 (i5 or higher), RAM minimum 4 GB; 

A3 / A4 size printer / plotter. Display-

wide Screen preferably. 

As  per 

batch 

size 

 

2. 

 

Operating system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 

As  per 

batch 

size 

 

3. 

 

Software 

Any parametric solid modeling 

software. 

As  per 

batch 

size 

4. Plotter Plotter A2 OR A3Size. 1 

 

IX Precautions to be Followed 

 Units used while designing the individual models should be properly selected. 

 

X Procedure 

Step 1: Set working directory and open assembly  

1. Start Solid Modeling Parametric CAD software.  

2. Set the working directory as explained in earlier practical’s. 

3. Opening the new assembly model  of screw jack:  

 From the Quick Access toolbar click on Opentab. The file open dialog box 

opens.  

 
File open dialog box. 

 If necessary click on Working Directory in the left panel.  

 Select your assembly-of-screw-jack.asm file and click open.  

 

Step 2: New Engineering Drawing. 

1. Starting a new drawing:  

 In the Quick Access toolbar, click on to start a new file.  
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New dialog box. 

 In the New dialog box, click Drawing for the Type and type in Assembly-of-

screw-jack for the Name.  

 Uncheck the Use default template option.  

 Click on OK and New Drawing dialog box opens.  

 A ‘New Drawing’ dialog box will pop up, browse default model as assembly 

file. 

 From Specify Template select ‘Empty with format’ option. 

 
New drawing dialog box. 

 Then from Format option browse and select the template as you need (or 

paper size you require).  

 Click OK to create the drawing. 

 Drawing environment with selected template will open.  
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Drawing Environment with Template. 

 

 From LAYOUT Tab select GENERAL from model views. 

 

 
General view. 

 

 
Select combined state dialog box. 

 

 Just click on OK button from Select Combined State dialog box. 

 Click in the drawing area where you want to insert the General view. 

 Then from Drawing View dialog box, select FRONT as a Model view name. 
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 Click on Apply and then click Close to close drawing view dialog box. 

 

 
Drawing view. 

 

 Select generated Front view, then click on Projection from Layout tab. 

 To get Top view click below the Front view.  

 
Projection view. 

 

 Repeat above two steps to get Side view. 

 

 
Drawing views before hidden display style. 
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 Double click on the generated Front view, we will get the drawing view 

dialog box again.  

 From Categories select View Display and select Hidden Display style. 

 Click on Apply and then Close.  

 

 
Application of hidden display style. 

 

 Repeat the above three steps twice to convert the top view and side view as 

Display style Hidden, simultaneously. 

 

 
Drawing views after hidden display style. 

 

2. Changing the drawing scale:  

Automatic obtained drawing views has a size comparatively smaller than that 

of the paper size. Therefore increase the scale to match the size of the model 

views to the paper size. 

 

 Double click on General views (initially inserted) to get open Drawing View 

dialog box.  

 From Categories select Scale, then choose Custom scale from Scale and 

perspective options. 

 Change the Custom scale as required.  
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 Then click Apply and say OK. 

 

 
Application of drawing scale. 

 

 

 After specifying the suitable scale, we will get the views as shown below. 

 Drawing view displays the Scale factor below the view. 

 

 
Scaled 3 drawing views. 

 

3. Showing dimensions:  

 

 In the drawing ribbon make sure the Annotate tab is selected.  

 In the graphics window, select the view you want to add dimensions to. The 

border of the sketch will turn green showing it is selected.  

 In the Annotate ribbon, click on Show Model Annotations. 
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(a)– Model Annotation. 

 

 Click on the view you want to add the dimensions. 

 The Show Model Annotations dialog box will open listing all the dimensions 

that were used to create the 3D model. 

 

 
(b)– Model Annotation. 

 

These can be checked/ticked individually to make them appear on the drawing in the 

select view. Near the bottom of the dialog box is a button to add all the dimensions 

 Click  to show all dimensions on the selected view. 

 

The dimensions will appear on the selected view but may or may not be placed 

properly. Then place it properly. Delete the dimensions which are not required.  

 

   OR 

 

 We can place the dimensions by selecting Dimension – New References tool 

and picking individual entities.  
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Dimension – New References 

 

 Finally generate the Drawing views as shown below. 

 

 
Assembly drawing views with all aspects. 

 

4. The Bill of Material:  

The Bill of Material is a tabular representation of all the components of the 

assembly, along with the information associated with them. 

 Click on Open to browse and open the Assembly file (i.e. 

Assembly_of_Screw_Jack.asm). 
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Assembly for Bill of material. 

 

 Select and click ‘Bill of Materials’ tool from Investigate. 

 

 
Bill of materials tool. 

 BOM dialog box will display, from this dialog box keep selected Top level 

and check Designated Objects. 

 Then click OK button.  

 
Bill of materials dialog box. 
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Bill of materials. 

XI Resources Used  

 

S. 

No. 

Name of 

Resource 

Broad Specifications 
Quantity 

Remarks 

(If any) Make Details 

1.       

2.       

3.       

 

XII Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIII Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIV Course Proficiency 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  
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XV  Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

 

1. Explain to generate BOM. 

2. Assemble and Print the orthographic views of any one of the following assembly –  

             Bench vice, Drill Jig, Tool Post. 

 

[Space for Answer] 

 ......................................................................................................................................................  
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 ......................................................................................................................................................  
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 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 

XVI References / Suggestions for Further Reading 

1. https://www.youtube.com/watch?v=qlXXN872GqA&feature=youtu.be 
2. https://www.youtube.com/watch?v=mBScLZ5yy58 

 

XVII  Assessment Scheme 

Performance Indicators Weightage 

Process Related (10 Marks) 40% 

1  Use of proper commands.   20% 

2 Completion of drawing with minimum size of 

model tree. 
20% 

Product Related (15 Marks) 60% 

3 Generation and printing of drawing views, tables, 

etc. and their arrangement on different sheet size. 
20% 

4 Able to answer oral questions. 20% 

5 Completion of work in time.  20% 

Total (25 Marks) 100 % 

 

Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………… 

 

 

 

 

 

 

 

 

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.youtube.com/watch?v=qlXXN872GqA&feature=youtu.be
https://www.youtube.com/watch?v=mBScLZ5yy58
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Practical No.12: Draw and Print the production drawing of all 

individual components part models of assembly 

developed in PrO 5 to 8. 

 
I Practical Significance 

Drawing and documentation are essential for any product design, because they provide 

guidance in the manufacturing of mechanical devices. While creating part model we 

might have given various dimensions, geometric constraints, these details are used in 

drawing mode directly.   Drawing views provide a means communication between the 

design engineers and production personnel. By studying this practical one can 

automatically create orthographic and detail views of either a 3D model or an 

assembly. Also here we can select multiple item types such as Dimension, Axis, 

Surface Finish and their options at a time. 

 

II      Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and 

allied industry.  

 

III Competency and Skills 

This practical is expected to develop the following skills for the industry identified 

competency –  

 Opening an existing component.  

 Creating of General and projection views. 

 Apply dimensions to the drawing views. 

 

IV Relevant Course Outcome(s) 

 Generate orthographic views of 3D solid models using Drawing workbench of any 

parametric CAD software. 

 Generate production drawing for given part models. 

 

V Practical Outcome 

 Use any available parametric CAD modeling software to create and print 

orthographic views of individual models for any engineering products. 

 

VI Relative Affective Domain- 

 Demonstrate working as a leader/a team member. 

 Follow ethical Practices. 
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VII Minimum Theoretical Background 

 Knowledge of drawing workbench of CAD modeling software. 

 Types and Method of dimensions. 

 Basic knowledge of reference projection views. 

 Dimensional tolerances, tolerances methods and types. 

 Geometrical &Dimensional Tolerances (GD&T). 

 

In addition to Dimensional Tolerance, we must show geometric tolerances on a 

component for manufacturing. Dimensional tolerances control the size of a component 

whereas geometric tolerance controls the shape of the component. The various 

parameters shown by Geometric Tolerances are geometric conditions such as surface 

finish, perpendicularity, circularity etc. 

Geometric Dimensioning and Tolerance (GD&T) is a symbolic language which 

communicates design intents. Geometric Dimensioning is a geometric characteristic 

the size of which is specified such as length, angle, location, or center distance. 

Geometric Tolerance is the total permissible variation in its size, which is equal to the 

difference between the limits of size, it states the maximum allowable variations of a 

form or its position from the perfect geometry implied on the drawing. Dimensional 

tolerance controls size of a part whereas Geometrical tolerance controls the shape of a 

part.  

It is used to specify the size, shape, form, orientation, and location of features on a 

part. And it is basically a very good design tool. To apply GD&T one must have the 

parts functionality in an assembly. 

 

VIII Resources Required 
 

S. 

No. 
Name of Resource Suggested Broad Specification Quantity 

 

1. 

 

Hardware: Personal 

computer. 

 (i5 or higher), RAM minimum 4 GB; 

A3 / A4 size printer / plotter. Display-

wide Screen preferably. 

As  per 

batch 

size 

 

2. 

 

Operating system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 

As  per 

batch 

size 

 

3. 

 

Software 

Any parametric solid modeling 

software. 

As  per 

batch 

size 

4. Plotter Plotter A2 OR A3Size. 1 

 

IX Precautions to be Followed 

 Units used while designing the individual models should be properly selected. 

 While taking drawing views, general view should take carefully. 

 Care should be taken while applying dimensions, like placement of dimension and 

should not repeat the same dimension. 
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X Procedure 
 

Step 1: Set working directory and open body part 
 

1. Start Solid Modeling Parametric CAD software.  

2. Set the working directory as explained in earlier practical’s. 

3. Opening the new part model body of screw jack:  

 From the Quick Access toolbar click on Open tab. The file open dialog box 

opens.  

 

 
File open dialog box. 

 If necessary click on Working Directory in the left panel.  

 Select your part model body11.prt and click open.  

Step 2: New Engineering Drawing. 

1. Starting a new drawing:  

 In the Quick Access toolbar, click on to start a new file.  

 In the New dialog box, click Drawing for the Type and enter as Body in Name 

field.  

 Uncheck the Use default template option.  

 Click on OK and New Drawing dialog box opens.  

 

 
New dialog box. 

 A ‘New Drawing’ dialog box will pop up, browse default model as body file. 

 From Specify Template select ‘Empty with format’ option. 
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New drawing dialog box. 

 

 Then from Format option browse and select the template as you need (or 

paper size you require).  

 Click OK to create the drawing. 

 Drawing environment with selected template will open.  

 
Drawing Environment with Template. 

 From LAYOUT Tab select GENERAL from model views. 

 
General view. 
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Select combined state dialog box. 

 Just click on OK button from Select Combined State dialog box. 

 Click in the drawing area where you want to insert the General view. 

 Then from Drawing View dialog box, select FRONT as a Model view name. 

 Click on Apply and then click Close to close drawing view dialog box. 

 
Drawing view. 

 Select generated Front view, then click on Projection from Layout tab. 

 To get Top view click below the Front view.  

 
Projection view. 

 Repeat above two steps to get Side view. 
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Drawing views before hidden display style. 

 

 Double click on the generated Front view, we will get the drawing view 

dialog box again.  

 From Categories select View Display and select Hidden Display style. 

 Click on Apply and then Close.  

 

 
Application of hidden display style. 

 Repeat the above three steps twice to convert the top view and side view as 

Display style Hidden, simultaneously. 
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Drawing views after hidden display style. 

3. Changing the drawing scale:  

Automatic obtained drawing views has a size comparatively smaller than that 

of the paper size. Therefore increase the scale to match the size of the model to 

the paper size. 

 Double click on General views (initially inserted) to get open Drawing View 

dialog box.  

 From Categories select Scale, then choose Custom scale from Scale and 

perspective options. 

 Change the Custom scale as required.  

 Then click Apply and say OK. 

 

 
Application of drawing scale. 

 After specifying the suitable scale, we will get the views as shown below. 

 Drawing view displays the Scale factor below the view. 
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4. Showing dimensions:  

 In the drawing ribbon make sure the Annotate tab is selected.  

 In the graphics window, select the view you want to add dimensions to. The 

border of the sketch will turn green showing it is selected.  

 In the Annotate ribbon, click on Show Model Annotations. 

 

 
Model Annotation. 

 

The Show Model Annotations dialog box will open listing all the dimensions that 

were used to create the 3D model.These can be checked/ticked individually to make 

them appear on the drawing in the select view. Near the bottom of the dialog box is a 

button to add all the dimensions.       

 

 Click  to show all dimensions on the selected view. 

 

The dimensions will appear on the selected view but may or may not be placed 

properly. Then place it properly. Delete the dimensions which are not required.  

   OR 

 

 We can place the dimensions by selecting Dimension – New References tool and 

picking individual entities.  

 

 
Dimension – New References 

 Finally generate the Drawing views as shown below. 
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Body part drawing views. 

 

5. Showing the Dimensional Tolerance : 

 By default dimensional tolerance are not shown in the drawing. To show dimensional 

tolerance on a drawing invoke File>Prepare>Drawing Properties from main menu 

bar. It display Model properties dialog box.  

 
Model Properties. 

 

 From this dialog box select change from Detail Options. Then it displays drawing 

configurations file window.  

 Search tol_display option and change its default value NO to YES. 

 
(a)–Tolerance Display Option. 

 
(b)–Tolerance Display Option. 
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 To change the display mode of tolerance, double click on a dimension, following 

dialog box will be seen. 

 Then from this dialog box select Tolerance>Tolerance Mode>Plus-Minus and say OK. 

 
Three views with dimension properties dialog box. 

 

6. Geometric Dimensions & Tolerances (GD&T) : 

 To add geometric tolerances invoke Annotate>Geometric Tolerances   from 

ribbon menu which displays Geometric Tolerance doalog box as shown in Figure. 

 
Geometric Tolerance dialog box.  

 Symbol  Tolerance is default selected.  

 

 Tolerance quantity is mentioned in the Tol Value option as shown in Figure. Here 

tolerance value is 0.001. 

 In Model Ref. Tab option, select ‘Select Entity’ and clickon the entityof the drawing 

to which tolerance to be provide. Select ‘Place Gtol’ tab and then select dimension 

from the part. 
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Selection of Geometric Tolerance. 

 To add geometric tolerance flatness. Select flatness symbol   . 

 Flatness quantity is mentioned in the Tol Value option as shown in Figure. Here 

tolerance value is 0.001. 

 In Model Ref. Tab option, select ‘Select Entity’ and clickon the entityof the drawing 

to which flatness to be providing. Select ‘Place Gtol’ tab and then select dimension 

from the part. Click OK button. 

 Geometric tolerance flatness will appear on respective entity as shown in Figure. 

 
Application of Geometric Tolerance. 

 

7. Surface Finish Symbol : 

 Invoke Annotate>Surface finish  from ribbon 

menu mode. 

 Click Retrieve option and open Generic/Unmachined or machined folder. 

Here we open Unmachined folder and open standard2.sym. Select 

Normal option, then select an entity or an edge or a dimension or a curve 

or a point on a surface from drawing views and then enter roughness value 

= 34. Then click Check option as shown in Figure. 

 



Solid Modelling and Additive Manufacturing (22053) 

 214 

 

Surface roughness value and symbol. 

8. Datum Reference Frames : 

We must define datum reference before applying geometric tolerance. 

 Create Reference Datum-The reference must be created earlier to apply geometric 

tolerances.  

a) Reference Datum’s are created by clicking Annotate>Model datum>Model 

Datum plane from ribbon menu, a datum dialog box is 

displayed as shown in Figure. 

 
Selection of Datum Reference. 

Enter the name of datum as A and click right button from the Display frame

to enclose the datum inside a feature control frame. 

 

b) Click Define, select Through> Plane option and select BASE plane of the 

screw jack body and click Done. Reference datum is created. 

 

 
Application of Datum Reference. 
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9. Show Geometric Tolerance :  

We have place reference datum either on views or on a selected dimensions. To 

add geometric tolerance invoke Annotate> Geometric Tolerance from ribbon 

menu. 

a) Click on  parallel button. 

 

b) Select Datum Ref. tab option and select Primary A. 

 

 
(a)– Geometric Tolerance. 

 

c) Select Tol Value option and enter the tolerance value = 0.003 

 
(b)– Geometric Tolerance. 

 

d) Click Model Refs tab. Select surface option as shown in Figure. 

Then select the surface which parallel to base surface of the screw jack 

body.  

 
(a)– Selection of Surface reference. 
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(b)– Selection of Surface reference. 

 

e) Select Type of Placement as With Leader and clickon the sameTop 

plane of body sketch placement. Click on Done. 

 

 
 Geometric Tolerance. 

f) Finally click OK button Geometric Tolerance is created as shown in 

Figure. 

 

 
View with Tolerance. 
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Drawing views of body part with all aspects. 

 

Continued in Next Practical – ----- 
 

XI Resources Used  

 

S. 

No. 

Name of 

Resource 

Broad Specifications 
Quantity 

Remarks 

(If any) Make Details 

1.       

2.       

3.       

 

XII Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIII Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  
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 ..........................................................................................................................................  

XIV Course Proficiency 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XV  Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

 

1. Explain the procedure for Projection views.  

2. Create drawing views of all the individual components (models) of Tool Post and 

Print it. 

[Space for Answer] 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 

XVI References / Suggestions for Further Reading 

1. https://www.youtube.com/watch?v=qlXXN872GqA&feature=youtu.be 

2. https://www.youtube.com/watch?v=mBScLZ5yy58 

 

XVII  Assessment Scheme 

Performance Indicators Weightage 

Process Related (10 Marks) 40% 

1  Use of proper commands.   20% 

2 Completion of drawing with minimum size of 

model tree. 
20% 

Product Related (15 Marks) 60% 

3 Generation and printing of drawing views, tables, 

etc. and their arrangement on different sheet size. 
20% 

4 Able to answer oral questions. 20% 

5 Completion of work in time.  20% 

Total (25 Marks) 100 % 

 

Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………… 

 

 

 

 

 

 

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.youtube.com/watch?v=qlXXN872GqA&feature=youtu.be
https://www.youtube.com/watch?v=mBScLZ5yy58
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Practical No.13: Draw and Print the production drawing of all 

individual components part models of assembly 

developed in PrO 5 to 8. 

                         --------------- Continued From Previous Practical. 
 

 

I Practical Significance 

Drawing and documentation are essential for any product design, because they provide 

guidance in the manufacturing of mechanical devices. While creating part model we 

might have given various dimensions, geometric constraints, these details are used in 

drawing mode directly.   Drawing views provide a means communication between the 

design engineers and production personnel. By studying this practical one can 

automatically create orthographic and detail views of either a 3D model or an 

assembly. Also here we can select multiple item types such as Dimension, Axis, 

Surface Finish and their options at a time. 

 

II     Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and 

allied industry.  

 

III Competency and Skills 

This practical is expected to develop the following skills for the industry identified 

competency –  

 Automation – borders, title blocks, views.  

 Creating of General and projection views. 

 Apply dimensions to the drawing views. 

 

IV Relevant Course Outcome(s) 

 Generate orthographic views of 3D solid models using Drawing workbench of any 

parametric CAD software. 

 Generate production drawing for given part models. 

 

V Practical Outcome 

 Use any available parametric CAD modeling software to create and print 

orthographic views of individual models for any engineering products. 
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VI Relative Affective Domain- 

 Working in team work. 

 Practice good housekeeping. 

 Demonstrate working as a leader/a team member. 

 Follow ethical Practices. 

 

VII Minimum Theoretical Background 

 Knowledge of drawing workbench of CAD modeling software. 

 Types and Method of dimensions. 

 Basic knowledge of reference projection views. 

 Geometrical &Dimensional Tolerances (GD&T). 

 

VIII Resources Required 
 

S. 

No. 
Name of Resource Suggested Broad Specification Quantity 

 

1. 

 

Hardware: Personal 

computer. 

 (i5 or higher), RAM minimum 4 GB; 

A3 / A4 size printer / plotter. Display-

wide Screen preferably. 

As  per 

batch 

size 

 

2. 

 

Operating system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 

As  per 

batch 

size 

 

3. 

 

Software 

Any parametric solid modeling 

software. 

As  per 

batch 

size 

4. Plotter and 3D printer 3D printer / Rapid 

prototypingMachine. 

1 

 

IX Precautions to be Followed 

 Units used while designing the individual models should be properly selected. 

 While taking drawing views, general view should take carefully. 

 Care should be taken while applying dimensions, like placement of dimension 

and should not repeat the same dimension. 

 

X Procedure 
 

To get the Drawing views of Nut, Spindle Screw & Cup components (models) of 

Screw Jack individually, follow same steps explained in Practical No.-12.  
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Nut part drawing views with all aspects. 

 

 
Screw Spindle part drawing views with all aspects. 
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Cup part drawing views with all aspects. 

 

XI Resources Used  
 

S. 

No. 

Name of 

Resource 

Broad Specifications 
Quantity 

Remarks 

(If any) Make Details 

1.       

2.       

3.       

 

XII Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIII Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIV Course Proficiency 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  
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XV  Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

1. Different template options available in drawing.  

2. Create drawing views of all the individual components (models) of Bench vice and 

Print it. 

[Space for Answer] 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 

XVI References / Suggestions for Further Reading 

1. https://www.youtube.com/watch?v=qlXXN872GqA&feature=youtu.be 
2. https://www.youtube.com/watch?v=mBScLZ5yy58 

 

XVII  Assessment Scheme 

Performance Indicators Weightage 

Process Related (10 Marks) 40% 

1  Use of proper commands.   20% 

2 Completion of drawing with minimum size of 

model tree. 

20% 

Product Related (15 Marks) 60% 

3 Generation and printing of drawing views, tables, 

etc. and their arrangement on different sheet size. 

20% 

4 Able to answer oral questions. 20% 

5 Completion of work in time.  20% 

Total (25 Marks) 100 % 

 

Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………… 

 

 

 

 

 

 

 

 

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.youtube.com/watch?v=qlXXN872GqA&feature=youtu.be
https://www.youtube.com/watch?v=mBScLZ5yy58


Solid Modelling and Additive Manufacturing (22053) 

 226 

Practical No.14: Draw and Print the production drawing of all 

individual components part models of assembly 

developed in PrO 5 to 8. 

                             ---------------- Continued From Previous Practical –  
 

I Practical Significance 

Drawing and documentation are essential for any product design, because they provide 

guidance in the manufacturing of mechanical devices. While creating part model we 

might have given various dimensions, geometric constraints, these details are used in 

drawing mode directly.   Drawing views provide a means communication between the 

design engineers and production personnel. By studying this practical one can 

automatically create orthographic and detail views of either a 3D model or an 

assembly. Also here we can select multiple item types such as Dimension, Axis, 

Surface Finish and their options at a time. 

 

II        Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and 

allied industry.  

 

III Competency and Skills 

This practical is expected to develop the following skills for the industry identified 

competency –  

1.  Opening an existing component.  

2. Starting a new drawing - paper size, template.  

3. Automation – borders, title blocks, views.  

4. Creating of General and projection views. 

5. Apply dimensions to the drawing views. 

 

IV Relevant Course Outcome(s) 

 Generate orthographic views of 3D solid models using Drawing workbench of any 

parametric CAD software. 

 Generate production drawing for given part models. 

 

V Practical Outcome 

 Use any available parametric CAD modeling software to create and print 

orthographic views of individual models for any engineering products. 
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VI Relative Affective Domain- 

 Working in team work. 

 Practice good housekeeping. 

 Demonstrate working as a leader/a team member. 

 

VII Minimum Theoretical Background 

 Knowledge of drawing workbench of CAD modeling software. 

 Types and Method of dimensions. 

 Basic knowledge of reference projection views. 

 Geometrical and Dimensional Tolerances (GD&T). 

 

VIII Resources Required 
 

S. 

No. 
Name of Resource Suggested Broad Specification Quantity 

 

1. 

 

Hardware: Personal 

computer. 

(i5 or higher), RAM minimum 4 GB; 

A3 / A4 size printer / plotter. Display-

wide Screen preferably. 

As  per 

batch 

size 

 

2. 
 

Operating system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 

As  per 

batch 

size 

 

3. 
 

Software 

Any parametric solid modeling 

software. 

As  per 

batch 

size 

4. 
Plotter and 3D printer 

3D printer / Rapid prototyping 

Machine. 
1 

 

IX Precautions to be Followed 

1. Units used while designing the individual models should be properly selected. 

2. While taking drawing views, general view should take carefully. 

 

X Procedure 

To get the Drawing views of Washer, Screw & Tommy Bar components (models) of 

Screw Jack individually, follow same steps explained in Practical No.-12.  
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Washer part drawing views with all aspects. 

 

 
Screw part drawing views with all aspects. 
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Tommy part drawing views with all aspects. 

 

XI Resources Used  

 

S. 

No. 

Name of 

Resource 

Broad Specifications 
Quantity 

Remarks 

(If any) Make Details 

1.       

2.       

3.       

 

 

XII Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIII Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  
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XIV Course Proficiency 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XV  Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

1. Explain the procedure of dimensioning on drawing views.  

2. Create drawing views of all the individual components (models) of Drill Jig 

and Print it. 

 

[Space for Answer] 

 

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 

XVI References / Suggestions for Further Reading 

1. https://www.youtube.com/watch?v=qlXXN872GqA&feature=youtu.be 
2. https://www.youtube.com/watch?v=mBScLZ5yy58 

 

XVII  Assessment Scheme 

Performance Indicators Weightage 

Process Related (10 Marks) 40% 

1  Use of proper commands.   20% 

2 Completion of drawing with minimum size of 

model tree. 
20% 

Product Related (15 Marks) 60% 

3 Generation and printing of drawing views, tables, 

etc. and their arrangement on different sheet size. 
20% 

4 Able to answer oral questions. 20% 

5 Completion of work in time.  20% 

Total (25 Marks) 100 % 

 

    Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………… 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.youtube.com/watch?v=qlXXN872GqA&feature=youtu.be
https://www.youtube.com/watch?v=mBScLZ5yy58
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     Practical No.15: Print One Simple Component Using 3D  

                                  Printer/Rapid Prototyping Machine. 

 
I. Practical Significance 

3D Printing technology could revolutionize and re-shape the world. Advances in 3D 

printing technology can significantly change and improve the way we manufacture 

products and produce goods worldwide.3D Printing can revolutionize the learning 

experience by helping students interact with the subject matter. Affordable 3D printers 

in institute may be used for a variety of applications which can aid students in finding 

their field of interest easier and faster. Currently there are different types of 

educational projects in order to attract students to the various fields by giving them the 

opportunity to create and fabricate their own designs using 3D printing technology. 

The ability to develop and present ideas is one of the most important needs in the 

student and society. The education system plays an important role in aiding people 

achieve their full potential and human development. Regarding this 3D printing can 

enable the creation of complex geometries which are very difficult, expensive, or 

impossible to be manufactured using conventional production methods.  

 

II. Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and 

allied industry.  

 

III.  Competency and Skills 

This practical is expected to develop the following skills for the industry identified 

competency ‘Create component model in CAD software and produce it using 3D 

Printer. 

 

IV.  Relevant Course Outcome(s) 

 Print component using 3D Printer/Rapid prototyping machine. 

 

V.  Practical Outcome 

 Design and create component model by CAD software and manufacturing it by 

3D printer. 

 

VI.  Relative Affective Domain- 

 Working in team work. 

 Practice good housekeeping. 

 Demonstrate working as a leader/a team member. 

 Follow ethical Practices. 
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VII. Minimum Theoretical Background 

 Basic knowledge of computer handling. 

 Basic knowledge CAD software. 

 Basic knowledge of  plastic material properties 

 

Introduction to 3D Printing: 
A method of manufacturing known as ‘Additive manufacturing’, due to the fact that 

instead of removing material to create a part, the process adds material in successive 

patterns to create the desired shape.  

Main areas of use:  

 – aerospace, military, biomedical engineering, 

dental  

 – medical (body parts), buildings 

and cars  

3D printer- 

Software Overview- 

To operate your desktop 3D printer you will need to install a few software packages 

onto your PC. You will need a 3D printer host, and .STL to .GCODE generator, and 

optional CAD or 3D modeling software. 

Printer Hosts- 

Printer Host software is used to control the 3D printer. The program not only allows 

you to manually move the printer along all the axes, but set temperatures manually, 

send commands, and receives feedback/error messages from the onboard electronics. 

CAD and 3D Modeling Software- 

 Other common CAD and 3D modeling software are also capable of exporting the 

required .STL files. 

 

VIII. Experimental setup  
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IX.  Resources Required 
 

Sr. 

No. 
Name of Resource Suggested Broad Specification Quantity 

 

1. 

 

Hardware: Personal 

computer. 

 (i5 or higher), RAM minimum 4 GB; 

A3 / A4 size printer / plotter. Display-

wide Screen preferably. 

As  per 

batch 

size 

 

2. 

 

Operating system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 

As  per 

batch 

size 

 

3. 

 

Software 

Any parametric solid modeling 

software. 

As  per 

batch 

size 

4. 3D printer 3D printer / Rapid prototyping 

Machine. 

1 

 

X.  Precautions to be Followed 

1. The part needs to be a solid, that is, not just a surface; it needs to have a real 

volume.  

2. Be sure to calibrate the 3D printer before using it, it is essential to ensure that the 

part sticks properly to the build plate. If it does not, at some point the part may 

come loose and ruin the entire print job.  

3. Parts with overhanging features will need supports to be printed properly. This 

should be taken into account since after the model needs to be cleaned by 

removing the supports. This may not be an issue unless the part is very delicate, 

since it might break.  

 

XI.  Procedure- 
Following two views of the component drawing are given to manufacture by 3D 

printer.   

 
The following steps are required to manufacture component by 3D printer: 

A. Starting CAD software: As explain in practical No.01. 

B. Setting the Working Directory: As explain in practical No.01. 

C. Starting a New Object File:As explain in practicalNo.04. 
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D. Selecting the Sketching Plane for the Base Feature: Asexplainimpractical No.4. 

E. Creating and Dimensioning the Sketch for the Base Feature: As explain in 

practical No.04 

 
The first extruded feature is completed as shown in Figure. 

 
F. Creating and Dimensioning the Sketch for the second Feature: As explain in 

practical No.04 

 
 

The second extruded feature is completed and as shown in Figure. 

 

 
G. Creating and Dimensioning the Sketch for the third Feature:As explained in 

practical No.04 

 
 

     Finally CAD model is shown in Figure. Choose the Save button from the File toolbar  

     and save the model. 
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H. The important step is that you have to Save As above CAD Model with .stl file 

extension.  

 
I. Start 3D print software: 

1. Start 3D printer software by double-clicking on the   icon on the desktop of your 

computer. (Here Additive manufacturing Edition software used for demo). 

2. After setting up Additive manufacturing for the first time, you will be shown 

the main interface screen. 

 
J. Load Model File: 

1.Select the model you would like to print. Select Open File > Load Model. 

Once the file has been loaded, you will see a 3D rendering of your object on 

the build platform.  

2. Select PRACTICAL15_CADMODEL_SIMPLEJOB.stl file from  

     working directory as shown in Figure. 

3. CAD Model, which was saved with .stlfile extension, will appear on the 

screen as shown in Figure. Select the model to see the various options. 
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K. Model Orientation: 

1. Rotate-The Rotate  button will give you the ability to orient your model 

in along all three axes. Once you click the rotate button, three circles will 

around your model. The red circle will allow you to rotate around the X axis. 

The Blue circle will rotate around the Z axis. The Green circle will rotate 

around the Y axis. 

2. Rotate model by in 360º around the X axis using rotate  button. 

 
3. Lay Flat- 

      The Lay Flat button will ensure that the flat portion of your print is securely 

attached to the bed. It is highly recommended to use this option after rotating 

your model in the Z direction, as it will help prevent adhesion issues during 

the print. 

 
L. Material Type Selection: 

1. Choose Material drop down menu and select ABS (Village Plastic) as 

shown in Figure. 

 
M. Adding 3D printer first time: 

1. Select Add Printer option as shown in Figure. 

The add printer new window will display on the screen. 

2. Select the Lulzbot TAZ 6 printer.   
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N. Machine setting: 

1. Specify machine setting if any as per component size. 

 
O. Process Parameter Options: Quality 

1. Layer Height-0.3mm 

      The thickness of each printed layer is known as the Layer Height. The smaller the   

      layer height, the smoother curves will appear. Larger layer heights are better for  

      bridging and overhang. Figure shows differences in Layer Height 

 

 

 
2. Initial layer height- The height of the initial layer in mm. A thickener initial  

      layer makes adhesion to the build plate easier. Enter 0.4mm initial layer height in  

      our job. 

 
3. Base Line Width-0.4 mm 

      This will define how wide your “support” material is for the raft. This setting will  

      determine how well the surface layers of the raft print.  

 
4. Wall line width-This is width of a single wall line and value will be 0.4 mm is  

      enough in our case. 

 
5. Outer wall line thickness-Width of outermost wall line by lowering the  

 value. Higher level of value will print detail. Again 0.4 mm is sufficient for our case. 
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6. Outer Wall Line Width-Width of outermost wall line. By lowering this value,  

     higher level of detail can be printed. Specify 0.4 mm value in our case. 

 
7. Inner walls line width-0.4 mm.It is width of a single wall line for all wall lines  

      except the outermost one. Enter 0.4 mm value for current job. 

 
8. Top /bottom line width-0.4 mm width of single top/bottom line. 

 
9. Infill line width -0.4mm 

 
10. Skirt/Brim line width-0.4 mm 

 
 

P. Process Parameter Options: Shell Setting 

1. Shell Wall Thickness- This defines the number of vertical walls that comprise the  

      outside of your model. We recommend keeping this set to multiples of your nozzle  

      width. Your 3D printer is equipped with a 1 mm nozzle. 

2. Wall line count-3 

 
3. Outer wall wipe distance-0.25 mm 

 
4. Bottom/Top Thickness (mm)- 

     Also known as Surface Layers- this will determine how thick the top and bottom  

    layers are. A larger number here will create a thicker top and bottom which can be  

    helpful for strength, bridging, and quality purposes. We recommend keeping this  

    number as a multiple of your layer height. For current job mention the value as 0.8  

    mm. 



Solid Modelling and Additive Manufacturing (22053) 

 240 

 
5. Top layers- 4 

 
6. Bottom layers-2 

 
7. Top /bottom pattern- Lines, Bottom pattern initial layers-lines, Outer wall inset- 

        0.05 mm 

 

 
 

Q. Process Parameter Options:Infill Setting- 

1. Infill Density- This number is expressed as a percentage. 0% will give a completely 

hollow print, while 100% will give you a completely solid object. We have found that 

20% to 40% fill density is functional for most prints. For current job use 30 % infill 

density. 

 
2. Infill line distance-1.33mm, Infill pattern-Lines 

 
3. Infill Overlap-0.04 mm 

 
4. Skin overlap percentage- 5% 

 
5. Skin overlap-0.02 mm 

 
6. Infill wipe distance-0.1 mm 

 
8. Infill Layer Thickness-This will control how thick your first printed layer height is 

printed onto the heated bed. Having a larger initial layer height will help prevent your 

part from popping off the plate.  
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7. Gradual infill steps-0 

 
8. Minimum infill area-0 mm

2
 

 
9. Skin expand distance-1.2 mm 

 
10. Minimum skin angle for expansion-90º 

11. Minimum skin width for expansion-00 

 
 

R. Process Parameter Options: Material setting 

1. Default printing temperature-240º 
C
 

 
2.Printing temperature-240º

C
 

 
3.Probe temperature-170º 

C
 

 
4.Soften temperature-170º 

C
 

 
5.Wipe temperature-170º

C
 

 
6.Printing temperature initial layer-245º 

C
 

 
 

S. Process Parameter Options: Printing Temperature 

When using different filament materials you’ll need to update the desired hot end and 

heated bed temperature. Any temperatures specified here will be used to automatically 

set both the hot end and heated bed. Your print will not begin until these temperatures 

are met. The current job needs 240º 
t
emperatures. 
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1. Final printing temperature-225 º 
c
 

 
2. Build plate temperature-110º 

C
 

 
3. Part removal temperature- 50º 

C
 

 
4. Keep heating-Tick 

5. Build plate temperature initial layer-110º
C
 

 
6. Filament Diameter- 

The filament diameter setting is one of the more important settings. Make sure that 

you update this value periodically with your average filament diameter. While your 

filament may be referred to as 3mm, it is more likely going to be near 2.9mm +/- 

0.1mm. You will want this to be an accurate average, as it will allow your printer to 

correctly calculate how much filament it is pulling into the hot end. For current case 

use value 2.25mm diameter. 

 
7. Enable Retraction-Tick 

Retraction tells your printer to pull filament out of the hot end upon travel moves. 

Travel moves are when your print head moves from one area of the print, to another 

without laying down filament. We recommend keeping this on for all filament types, 

and adjusting the retraction length and speed for the specific filament. For current 

job Tick the enable retraction option. 

8. Filament Flow -100% 

This controls how much filament your printer is extruding in relation to speed. This 

setting is mainly used to adjust for filament density variations. Leave this value at 

100% as changing it can lead to surface quality issues. 

 
9. Initial layer flow rate- 100% 

 
10. Retraction Distance-1 mm 

Retraction Distance determines how much filament is pulled out of your hot end on 

travel moves and when changing direction. You will want to adjust this depending 

on temperature settings and filament type. Higher thermal retaining filaments such 

as PLA behave better with a longer retraction distance. We have found anywhere 

from 1mm to 3mm is a good starting range. For our case use 1 mm. 
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11. Retraction Speed-10 mm/s 

Retraction Speed determines the speed at which your filament is reversed out of 

the hot end for travel moves and when changing direction during printing. We 

recommend keeping this set to 25mm/s. For our case use value 10 mm/s. 

 
12. Retraction retract speed- 10 mm/s 

 
13. Retraction prime speed-10 mm/s 

 
14. Retraction extra prime amount-0 mm

2
 

 
15. Retraction minimum travel-0.8 mm 

 
16. Maximum retraction count-90 

 
17. Minimum extrusion distance window-1 mm 

 
18. Nozzle switch retraction distance-16 mm 

 
 

T. Process Parameter Options: Speed 

1 Print speed- 100 mm/s 

Your overall printing speed can be adjusted here. If no other speeds are determined 

in the later sections your printer will automatically default to this speed. This speed 

will be different, depending on what type of filament you are using. 
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2 Infill Speed-55 mm/s 

This is how fast your print head speed will be while laying down the interior portion of 

your model. Faster speeds are usually tolerable here, as none of the infill will be 

visible from the outside of your object. If you go too fast compared to your inner and 

outer shells, you can have adhesion issues or globs of filament left behind from the 

print head. For current job give infill speed as 55 mm/s. 

 
3 Wall speed-50 mm/s 

 
4 Outer Shell Speed-45 mm/s 

This will be the outermost surface of the model. This is the most important setting, as 

it controls the speed of your print head on the visible layers. As a general rule of 

thumb, the slower you go the better looking print you will get. 

 
5 Inner Shell Speed-100 mm/s 

This affects vertical walls that are in between the outer shell and infill. This will not be 

visible but will help support the outer shell and the infill. We recommend keeping this 

speed setting between your infill and your outer shell speed. 

 
6 Bottom Layer Speed-45 mm/s 

This will control your initial layer speed. In general, a slower initial layerspeed will 

help with first layer adhesion. In our case speed required 45mm/s 

 

 
7 Travel Speed-175 mm/s 

This setting will determine how fast your print head moves while not extruding 

filament. A normal travel speed of 125 - 150mm/s is recommended. 

 
8 Initial layer speed-15 mm/s 

 
9 Initial layer print speed-15 mm/s 
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10 Initial layer travel speed- 26.26 mm/s 

 
11 Brim speed-15 mm/s 

Brim will create a single layer of filament, contacting and surrounding your model. 

This will increase the surface area of the part contacting the build platform thereby 

preventing it from popping off the heated bed. Brim will also help in situations where 

you are seeing corner lift. Brim settings can be adjusted in the Expert Settings options. 

 
12 Maximum Z speed-0 mm/s 

 
13 Number of slower layers-2 

 
U. Process Parameter Options: Support Type 

1. Generate support-Tick 

2. Support placement-Everywhere 

Some models will require support material in order to print properly. This will 

usually occur when an object has an angle in relation to the build plate between 0 

to 45 degrees. It is highly recommended to orient your object so that it minimizes 

or eliminates the need for support.This prints support material between the heated 

bed and object as well as between the object and itself. The green example is 

Support Everywhere.  

 

 
Figure- Support Types 

V. Process Parameter Options: Cooling 

1. Enable cooling fan-Tick 

2. Fan speed-100 % 
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This section will define how your extruder cooling fan will operate during the print. Your 

fan will not start until it has reached 25% or higher for speed settings. If your print speeds 

are slowed down due to minimal layer time, the fan will run between minimum and 

maximum speed based upon how much the layer is slowed down. 

 
3 Minimal Layer Time-20 s 

This will determine a minimum amount of time your printer will spend laying down each 

layer.  

 
W. Process Parameter Options: Built plate adhesion setting 

1 Build plate adhesion type- Brim 

 
4 Start/ brim minimum length-250 mm 

 
5 Brim width-80 mm 

 
6 Brim line count-10 

 
7 Click Save to file will start the 3D printing. 
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XII. Resources Used 

 

S. 

No. 

Name of 

Resource 

Broad Specifications 
Quantity 

Remarks 

(If any) Make Details 

1.       

2.       

 

XIII. Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIV. Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XV. Conclusions 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XVI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

1. Define ‘Additive Manufacturing’ 

2. Explain the working principle of 3D Printing Technology. 

 

[Space for Answer] 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 

XVII. References / Suggestions for Further Reading 

 https://www.youtube.com/watch?v=e0rYO5YI7kA 

 https://www.youtube.com/watch?v=HVgPM1ojyLw 

 

XVIII. Assessment Scheme 

Performance Indicators Weightage 

Process Related (10 Marks) 70% 

1  Selecting relevant material, process and set up 

parameters. 

30% 

2  Slicing the solid model and transferring the file to 

the printer.  

20% 

3  Printing the components. 20% 

Product Related (15 Marks) 30% 

4  Safety unloading the manufactured component 

from the printer/machine. 

10% 

5  Answer to sample questions. 10% 

6  Submission of digital drawing file/plot in time.  10% 

Total (25 Marks) 100 % 

 

Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………… 

 

 

 

 

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

https://www.youtube.com/watch?v=e0rYO5YI7kA
https://www.youtube.com/watch?v=HVgPM1ojyLw
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Practical No.16: Print One Complex Component Using 3D Printer/Rapid 

Prototyping Machine. 

 

I  Practical Significance 

3D Printing technology could revolutionize and re-shape the world. Advances in 3D 

printing technology can significantly change and improve the way we manufacture 

products and produce goods worldwide.3D Printing can revolutionize the learning 

experience by helping students interact with the subject matter. Affordable 3D printers 

in institute may be used for a variety of applications which can aid students in finding 

their field of interest easier and faster. Currently there are different types of 

educational projects in order to attract students to the various fields by giving them the 

opportunity to create and fabricate their own designs using 3D printing technology. 

The ability to develop and present ideas is one of the most important needs in the 

student and society. The education system plays an important role in aiding people 

achieve their full potential and human development. Regarding this 3D printing can 

enable the creation of complex geometries which are very difficult, expensive, or 

impossible to be manufactured using conventional production methods.  

 

II      Relevant Program Outcomes (POs) 

PO2-Discipline knowledge: Apply Mechanical engineering knowledge to solve 

broad-based mechanical engineering related problems.  

PO3-Experiments and practice: Plan to perform experiments and practices to use the 

results to solve broad-based Mechanical engineering problems.  

PO4-Engineering tools: Apply relevant Mechanical technologies and tools with an 

understanding of the limitations.  

PO10-Life-long learning: Engage in independent and life-long learning activities in 

the context of technological changes also in the Mechanical engineering and 

allied industry.  

 

III  Competency and Skills 

This practical is expected to develop the following skills for the industry identified 

competency ‘Create component model in CAD software and produce it using 3D 

Printer.  

 

IV  Relevant Course Outcome(s) 

 Print component using 3D Printer/Rapid prototyping machine. 

 

V Practical Outcome 

 Design and create component model by CAD software and manufacturing it by 

3D printer. 

 

VI Relative Affective Domain- 

 Working in team work. 

 Practice good housekeeping. 

 Demonstrate working as a leader/a team member. 

 Follow ethical Practices. 
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VII Experimental set up: 

 
 

VIII Minimum Theoretical Background 

 Basic knowledge of computer handling. 

 Basic knowledge CAD software. 

 Basic knowledge of  plastic material properties 

 Basic knowledge of 3D printing technology. 

 

IX Resources Required 
 

S. 

No. 
Name of Resource Suggested Broad Specification Quantity 

 

1. 

 

Hardware: Personal 

computer. 

 (i5 or higher), RAM minimum 4 GB; 

A3 / A4 size printer / plotter. Display-

wide Screen preferably. 

As  per 

batch 

size 

3. Software Any parametric solid modeling 

software. 

As  per 

batch 

size 

4. 3D printer 3D printer / Rapid prototyping 

Machine. 

1 

 

X Precautions to be Followed 

As explained in previous practical No.01. 

 

XI Procedure 
 

   Following views of the component drawing are given to manufacture by 3D printer. 
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       The following steps are required to manufacture component by 3D printer: 

A. Starting solid modeling CAD software.-As explained in practical No. 01 

B. Setting the Working Directory: As explained in practical No. 01 

C. Starting a New Object File:As explain in practicalNo.04. 

D. To create CAD Model: As explained in practical No.04, 15.CAD model is 

created and shown in Figure. 

 
E. You have to Save As above CAD model with.stlfile extension.  

 
F. Start 3D Printer software: As explained in practical No.15 

G. Load Model File:As explained in practical No.15 

           CAD Model, which was saved with .stl file extension, will appear on the  

           screen as shown in Figure. Click the model for orientation. 

H. Model Orientation: As explained in practical No.15 

1. Rotate model by in 90º around the X axis using rotate  button. 

2. Lay Flat-The Lay Flat button will ensure that the flat portion of your print is  

    securely attached to the bed. It is highly recommended to use this option after  

    rotating your model in the Z direction, as it will help prevent adhesion issues  

    during the print. 
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3. Resting the job on the table maintaining X= -64.56, Y=38.07 and Z=0, but  

       in your case mostly locate the job at the center position of the printer table. 

 
I.  Material Type Selection: As explained in practical No.15 

J. Process Parameter Options: Quality 

1. Layer Height-0.4 mm 

 
2. Initial layer height-0.5 mm 

 
3 Line Width-0.4 mm 

 
4 Wall line width-0.4 mm 

 
5. Outer wall line width-0.4 mm 

 
6. Inner wall line width-0.4 mm 

 
7. Top/Bottom line width-0.4 mm 
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8. Infill line width- 0.4 mm 

 
9. Skirt/brim line width-0.4 mm 

 
K. Process Parameter Options: Shell Setting: 

1 Wall thickness-10 mm 

 
2 Wall line count-3 

 
3 Outer wall wipe distance-0.25 mm 

 
4 Top/Bottom thickness- 0.8 mm 

 
5 Top thickness-1.1mm 

 
6 Top layers-03 

 
7 Bottom thickness-1.1 mm 

 
8 Bottom layers-03 

 
9 Outer wall inset-0.05 mm 

 
10 Horizontal expansion-00 mm 

 
11  Extra skin wall count-01 

 
 

L. Process Parameter Options:Infill Setting: 

1 Infill density- 30% 

 
2 Infill line distance-4.8 mm 

 
3 Infill pattern- Triangle 
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4 Infill overlap percentage-15 % 

 
5 Infill overlap-0.06 mm 

 
6 Skin overlap percentage-15 % 

 
7 Skin overlap- 0.06 mm 

 
8 Infill wipe distance-0.1 mm 

 
 

M. Process Parameter Options:Material setting 

1 Default printing temperature-250º 
C
 

 
2 Printing temperature-250º 

C
 

 
3 Probe temperature-170 º 

C
 

 
4 Soften temperature-170 º 

C
 

 
5 Wipe temperature-170 º 

C
 

 
6 Printing temperature initial layer-250º 

C
 

 
7 Initial printing temperature-250º 

C
 

 
8 Final printing temperature-250º 

C
 

 
9 Build plate temperature-110º 

C
 

 
10 Part removal temperature-50º 

C
 

 
11 Build plate temperature initial layer-110 º 

C
 

 
12 Diameter-2.25 mm 

 
13 Flow percentage-100% 
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14 Initial layer flow rate-100% 

 
15 Retraction distance-1mm 

 
16 Retraction speed-10 mm/s 

 
17 Retraction retract speed-10 mm/s 

 
18 Retraction prime speed-10 mm/s 

 
19 Retraction extra prime amount-00 mm

2
 

 
20 Retraction minimum travel-0.8 mm 

 
21 Maximum retraction count-90 

 
22 Minimum extrusion distance window-1 mm 

 
23 Nozzel switch retraction distance-16 mm 

 
24 Nozzle switch retraction speed-20 mm/s 

 
25 Nozzle switch retract speed-20 mm/s 

 
26 Nozzle switch prime speed-20 mm/s 

 
 

N. Process Parameter Options: Speed 

1 Print speed-150 mm/s 

 
2 Infill speed-150 mm/s 

 
3 Wall speed-75 mm/s 

 
4 Outer wall speed-50 mm/s 

5 Inner wall speed-70 mm/s 

6 Top/Bottom speed-70 mm/s 

7 Travel speed-180 mm/s 
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8 Initial layer speed-15 mm/s 

 
O. Process Parameter Options: Support 

1 Generate support-Tick 

2 Support stair step height-0.3 mm 

 
3 Support stair step maximum width-5 mm 

4 Tower roof angle-65º 

 
P. Process Parameter Options: Built plate adhesion setting 

1 Build plate adhesion type-Brim 

 
2 Skirt/Brim maximum length-200 mm 

 
3 Brim width-1 mm 

 
4 Brim line count-10 

 
5 Save file in working directory. 

6 Click Save to file will start the 3D printing. 
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7 Remove component carefully from printer table. 

 

XII Resources Used  
 

S. 

No. 

Name of 

Resource 

Broad Specifications Quantity Remarks 

(If any) Make Details 

1.       

2.       

3.       

 

XIII Actual Procedure Followed  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XIV Precautions Followed 

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XV  Conclusions  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 ..........................................................................................................................................  

 

XVI  Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions as to ensure the achievement of identified CO. 

 

1. Explain working principle of SLA – Stereo lithography. 

2. Write major benefits of 3D printing manufacturing technology. 

 

[Space for Answer] 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  
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 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 ......................................................................................................................................................  

 

XVII To manufacture 3D components by 3D printer for practice: 
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XVIII References / Suggestions for Further Reading 

 file:///C:/Users/Administrator/Downloads/cura-lulzbot_3.2.32.dmg 

 https://www.youtube.com/watch?v=e0rYO5YI7kA 

 https://www.youtube.com/watch?v=HVgPM1ojyLw 

 https://www.youtube.com/watch?v=89BQz6X3ntc 

 https://www.youtube.com/watch?v=LALTD5-TAkU 

 https://www.lulzbot.com/learn?type_1=tutorial 

 http://download.lulzbot.com/Software/cura-lulzbot/mac/cura-ulzbot_3.2.32.dmg 

 

 

XIX Assessment Scheme 

Performance Indicators Weightage 

Process Related (10 Marks) 70% 

1 Selecting relevant material, process and set up 

parameters. 
30% 

2 Slicing the solid model and transferring the file to 

the printer.  
20% 

3 Printing the components. 20% 

Product Related (15 Marks) 30% 

4 Safety unloading the manufactured component 

from the printer/machine. 
10% 

5 Answer to sample questions. 10% 

6 Submission of digital drawing file/plot in time.  10% 

Total (25 Marks) 100 % 

 

Names of Student Team Members 

1. …………………….. 

2. ………………………. 

3. ………………………… 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(10) 

Product 

Related(15) 

Total 

(25) 

 

   

file:///C:/Users/Administrator/Downloads/cura-lulzbot_3.2.32.dmg
https://www.youtube.com/watch?v=e0rYO5YI7kA
https://www.youtube.com/watch?v=HVgPM1ojyLw
https://www.youtube.com/watch?v=89BQz6X3ntc
https://www.youtube.com/watch?v=LALTD5-TAkU
https://www.lulzbot.com/learn?type_1=tutorial
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